CREATING A TRAINING MANUAL FOR A MIDWESTERN BOUTIQUE HOTEL

A project submitted to the
Kent State University College
of Education, Health and Human Services
in partial fulfillment of the requirements
for the degree of Master of Hospitality and Tourism Management

By

Amy E. Romanelli

August 2016
A thesis written by

Amy Romanelli

B.A., Kent State University, 2013

M.S., Kent State University, 2016

Approved by

__________________________, Director, Master’s Thesis Committee
Swathi Ravichandran

__________________________, Member, Master’s Thesis Committee
Aviad Israeli

__________________________, Member, Master’s Thesis Committee
Seon Jeong Lee

Accepted by

_____________________________, Director, School of Foundations Leadership
and Administration
Kimberly Schimmel

_____________________________, Dean, College of Education, Health and Human
Services
Mark Kretovics
The purpose of this research project was to create a training manual for the front office operations of an independent boutique-style hotel in a campus town in the Midwest. Researchers met with the hotel’s management team to review the current hotel policies and training material. Training manuals serve the important purpose of providing a consistent way to communicate instructions to employees about how to perform essential functions of their jobs. A review of professional hospitality and business articles on training and other resources revealed that experts perceived a strong correlation between training and many other factors in benefiting employee training. This study found employee training offered significant contributions to any organization in enhancing the abilities of their employees. Existing research has shown that hotel managers are reluctant to invest in proper training programs for their employees due to tight budgets and high turnover.
ACKNOWLEDGEMENTS

This research project would not have been possible without the support of many people. I would first like to thank my committee members, Dr. Avaid Israeli and Dr. Seon-Jeong Lee for their support and guidance throughout this process. I appreciate the vast knowledge and assistance they provided at all levels of the research project.

I would like to express my gratitude to Dr. Swathi Ravichandran, my thesis advisor, whose expertise, understanding, and patience, added considerably to my graduate experience. She has been a constant source of encouragement and enthusiasm, not only during this thesis project but also during the two years in my Master program. Dr. Ravichandran is the one professor who truly made a difference in my life.

I would also like to thank the Kent State University Hotel and Conference Center staff who welcomed me into the hotel to help create the front desk training manual for this thesis project. Thank you for believing in the project and providing necessary information regarding the project.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>ACKNOWLEDGEMENTS</th>
<th>iii</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CHAPTER</strong></td>
<td></td>
</tr>
<tr>
<td>I. INTRODUCTION</td>
<td>1</td>
</tr>
<tr>
<td>II. REVIEW OF LITERATURE</td>
<td>7</td>
</tr>
<tr>
<td>Benefits of Training in the Hospitality Industry</td>
<td>7</td>
</tr>
<tr>
<td>Employee Job Performance and Organizational Performance</td>
<td>7</td>
</tr>
<tr>
<td>Employee Satisfaction and Commitment</td>
<td>10</td>
</tr>
<tr>
<td>Reduced Work Stress</td>
<td>12</td>
</tr>
<tr>
<td>Employee Preferences for Training Approaches in the Hospitality Industry</td>
<td>13</td>
</tr>
<tr>
<td>Training Delivery Methods used in the Hospitality Industry</td>
<td>15</td>
</tr>
<tr>
<td>Traditional Training Methods</td>
<td>16</td>
</tr>
<tr>
<td>Use of Technology in Training</td>
<td>18</td>
</tr>
<tr>
<td>Effectiveness of Training Methods Used</td>
<td>20</td>
</tr>
<tr>
<td>Role of Training Professionals in the Service Industry</td>
<td>24</td>
</tr>
<tr>
<td>Training Evaluation</td>
<td>26</td>
</tr>
<tr>
<td>Training Younger Generations of Hospitality Employees</td>
<td>29</td>
</tr>
<tr>
<td>Training the Millenial Generation</td>
<td>29</td>
</tr>
<tr>
<td>Training Generation Z</td>
<td>32</td>
</tr>
<tr>
<td>III. METHODOLOGY</td>
<td>34</td>
</tr>
<tr>
<td>IV. THESIS PROJECT</td>
<td>37</td>
</tr>
<tr>
<td>V. RESULTS AND DISCUSSION</td>
<td>41</td>
</tr>
<tr>
<td>Future of Training Research in the Hotel Industry</td>
<td>44</td>
</tr>
<tr>
<td>APPENDICES</td>
<td>46</td>
</tr>
<tr>
<td>APPENDIX A: FRONT DESK MANUAL</td>
<td>47</td>
</tr>
<tr>
<td>REFERENCES</td>
<td>181</td>
</tr>
</tbody>
</table>
CHAPTER I

INTRODUCTION

Training refers to a systematic approach to learning and development to improve individual, team, and organizational effectiveness (Goldstein & Ford, 2002). The goal of training is for employees to master the knowledge, skill, and behaviors emphasized in training programs and to apply them to their day-to-day activities (Noe, 2010). Training plays a distinct role in the achievement of an organization’s goal by incorporating the interests of organizations and the workforce (Wahab, Hussain, Zadeh, Shah, & Hussain, 2014). In today’s dynamic world, training is of paramount importance because companies are experiencing great change due to new technologies, rapid development of knowledge, and globalization of business (Noe, 2010).

Employee training serves a variety of purposes, including, but not limited to, developing leadership skills (Ladyshewsky, 2007), learning new computer systems (Hasan, 2006), orienting new employees to the culture of an organization, and educating new employees with regard to their job responsibilities and business ethics (Weber, 2007). Training has been associated with a number of benefits including delivery of high quality customer service, consistency in employee job performance and satisfaction, as well as commitment to the organization (Roehl & Swerdlow, 1999). Chiang, Back, and Canter (2005) stated that training is linked to improvement in self-esteem, reduction in employee turnover, better product and service consistency, higher guest satisfaction, reduction in business costs, improvement in employee attitude, greater job satisfaction, and greater organizational commitment (Chiang, Back, & Canter, 2005).
The hospitality industry has typically been dominant in hiring employees, but not so fortunate in retaining them (Lee & Way, 2010). One of the main causes of high turnover in the hospitality industry is the lack of training (Poulston, 2008). Hospitality is an industry that has been long plagued by turnover rates traditionally ranging from 60% to 300% (Jones, 2008) resulting in lost training wages, frustrated accountants and financial statements screaming for a reduction in waste or lost human resource dollars. High turnover rates not only affect staff morale but also lead to loss of productive workers while reducing efficiency (Yang, Wan, & Fu, 2012). Employees are an organization’s foundation. It is critical that an organization retain valuable employees thus contributing to a skilled workforce (Lee & Way 2010).

Lack of training can also impact consistency and quality of customer service provision (Alonso & O’Neill, 2009). A large number of employees can appear dissatisfied due to being assigned responsibilities without having the right knowledge and skills in that area (Heinemann & Greenberger, 2002). Training programs have often been the object of criticism for being too expensive and because it does not achieve the transfer of acquired knowledge to the work position (Aguinis & Kraiger, 2009; Ubeda-Garcia, Cortes, Marco-Lajara, & Zaragoza-Saez, 2014). Management in hotels are reluctant to invest in proper training for their employees. With a lack of investment in proper training programs, a cycle has been created where poor training of employees and the consequential lack of employee motivation and commitment of employees will be never-ending (Chow, Haddad, & Singh, 2007).
The changing environment of the hotel industry is forcing them to develop and launch new innovative training programs for improving quality and reputation, efficiency and increasing market shares (Martinez-Ros & Orfila-Sintes, 2012). Sirilli and Evangelista (1998) argued that training activities are one of the main channels to upgrading a firm’s technology capabilities thus leading to successful innovation. Training results in more highly skilled employees who will make better use of new technologies and be capable of providing better or new services (Lopez-Cabrales, Valle, & Herrero, 2006).

A good training program provides a less formal, more flexible structural design and more highly skills workers to achieve the final objective (Martines-Ros & Orfila-Sintes, 2012). Training program design should systematically include the following eight stages: assessing training needs, defining training objectives, describing training objectives in detail, developing a training program, establishing assessment criteria, monitoring training progress, assessing training effectiveness, and obtaining feedback (Goldstein, 2002). A “one-size-fits-all” approach will not have the same motivational impact on employee retention and performance across the board (Yang, Wan, & Fu, 2012). Training programs need to meet employee expectations.

The continued use of traditional training methods in the hospitality industry is contributing to inadequate presentation of subject matter, lowered comprehension levels of employees, and the less than achievable levels of service quality (Harris & Cannon, 1995). As more innovative training methods and tools have become available, industry professionals have reported an increase in effectiveness and efficiency of training.
delivery, employee performance, and customer service (Durocher, 1990; Harris & Cannon, 1995). Unfortunately, the hospitality industry as a whole has been hesitant to incorporate innovative, training techniques that incorporate the latest technology to understand the powerful benefits.

As the hospitality industry becomes more heavily dependent on a skilled labor force, the desires and level of quality expectations are more broad and in depth than in the past (Reid & Sandler, 1992). Therefore, training will have to include a more educational format that will involve frequent and innovative teaching methods as well as more efficient instructional technology than is being currently used (Harris & Cannon, 1995). The preferred traditional training tools such as training manuals and classroom settings are not effective in providing additional information about a topic while restricting the amount of interaction between learners and a trainer (Kim & Kizildag, 2011).

Since the birth of computer networks and wireless network technologies, the learning experience has switched from face-to-face learning or in-class learning, distance learning, to electronic learning (e-learning) (Ting, 2005). The rapidly growing application of E-learning can reduce a company’s training costs, increase trainees’ convenience, and provide alternative to other forms of instruction (Kim, Erdem, Byum, Jeong, 2011). Through the use of technology, learners are provided with opportunities to have access to other learners in diverse contexts thus removing the geographical constraints attached to the learning process (Kumpikaite & Ciarniene, 2008). The major
potential benefit of e-learning is the capability for training to proceed at a pace that is appropriate to the learner.

The purpose of this research project is to create a training manual for front office operations of an independent boutique-style hotel in a campus town in the Midwest. The hotel has been operating for two-and-a-half years. As an independent property, a boutique hotel can be more readily identified as part of the community within which it is located, rather than as part of a large brand family (Hakan & Jamel, 2006). Boutique hotels differentiate themselves from large chain hotel by providing luxurious personalized accommodations and services, uniqueness, authenticity and enhanced customer experiences (Charke & Chen, 2007). Guests are attended to by 24-hour hotel staff. Many boutique hotels have on-site dining facilities and the majority offer bars and lounges which may also be open to the general public (Erkutlu & Chafra, 2006).

Conveniently located in the heart of a recently renovated and vibrant downtown area, the hotel that is part of this research project features 94 boutique-style guest rooms with amenities including a refrigerator, microwave, iPod docking stations, and a flat-screen TV. Between four meeting rooms, the hotel has over 5,000 square feet of flexible conference space with complimentary Wi-Fi and onsite catering options. The full service restaurant and bar, open 7 days a week, offers the finest cuisine in a sophisticated atmosphere. Other features include room service, heated indoor pool and whirlpool fitness center, 24 hour-business center, and convenient parking.

In chain hotels, training policies tend to be corporate-based, with variation for local needs (Taylor & Davis, 2004). Training in boutique hotels is generally provided
in-house without strict corporate guidelines to follow and tends to be based on the needs of the department in which employees are located (Taylor & Davis, 2004). Although, with the design and flexibility of implementing a personalized training program, the management team is responsible for developing the training programs to ensure consistency of service levels (Taylor & Davis, 2004).

This research project is divided into five main chapters. The first chapter provides an introduction to training in the hospitality industry and also discusses the benefits and challenges associated with training, specifically in the lodging segment. An organization of the project is also provided. The second chapter provides an overview of the current literature on the benefits of training, employee job performance and organizational performance, employee satisfaction and commitment, reduced work stress, employee preferences for training approaches, training delivery methods, traditional training methods, use of technology, effectiveness of training, role of training professionals, training evaluation, and training younger generations. The third chapter discusses the structure of a training manual in the context of the hospitality industry. The fourth chapter presents the front desk training manual created for the boutique hotel. This chapter showcases the actual manual including the mission and values, hotel information, people to know, job description overview, front desk reservations procedures, safety and security, rooms types, checklists, guest reward system, Innquest roomMaster practices, and a local directory. Finally, the fifth chapter offers a summary of the training manual development process and discusses the importance of updating the manual and the need for continuous training.
CHAPTER II

REVIEW OF LITERATURE

Benefits of Training in the Hospitality Industry

As organizations compete in the global economy, differentiation on the basis of the skills, knowledge, and motivation of their workforce increase in importance (Aguinis & Kraiger, 2009). Training and development programs have a direct influence on employee skills impacting both their competency levels and productivity, thus impacting job satisfaction (Costen & Salazar, 2011). Higher employee productivity improves work efficiency while also helping the organization gain competitive advantage and enhanced employee commitment (Meyer & Allen, 1990). Training has also been associated with a reduction in job stress and hence, reduction in absenteeism and employee turnover (Buick & Muthu, 1997).

Employee Job Performance and Organizational Performance

Benefits of training include improvements in both employee and organizational performance. Haynes and Fryer (2000) explored the effectiveness of human resource management (HRM) in a luxury lodging context. The study examined the policies and practices adopted by Fivestar, a luxury hotel in Auckland, New Zealand, to enhance both the level of skills of its staff and their commitment to a vision of excellence in service. Data was collected through open-ended interviews with managerial staff and examination of management documents. Employee training was altered to emphasize “leadership skills” to enhance employee competencies. Continuous improvements of the HRM
practices, including employee training, was found to be associated with clear and measureable positive effects on the hotel’s performance.

Swain and George (2007) studied human resource development practices and their impact upon employee’s performance in the classified hotels in Orissa, India. A survey instrument, *inter alia*, was used to gain knowledge employee perceptions relating to the need for training, benefits from training, and the relationship with promotions and organizational effectiveness. A total of 65 completed questionnaires were returned from the hotel organization’s employees. Based on the analysis, it was found that employees in the surveyed star hotels benefited from ongoing training practices.

In addition to improving employee job performance, training improves organizational performance by creating a workforce with extensive knowledge and skills (Tharenou, Saks, & Moore, 2007). Ubeda-Garcia, Marco-Lajara, Sabater-Sempere, and Garcia-Lillo (2013) researched the impact of training policies on organizational performance. The study was conducted within the hotel industry in the Valencian Autonomous Region of Spain. Survey data were collected from the CEOs of 112 hotel firms located in Alicante, Valencia, and Castellon. The results suggested that the hotel’s training policy positively correlated with organizational performance, using both objective measures such as productivity and financial performance and subjective measures such as perceived financial performance (Ubeda-Garcia et al., 2013).

Chand and Katou (2007) explored the gap between select HRM practices and organizational performance within the Indian hotel industry. A total of 439 hotels,
ranging from three-star to five-star deluxe, were selected from the Indian Ministry of Tourism classification list. Self-administered questionnaires were sent to the personnel managers of the participating hotels. Results indicated that investing in training and development improved service quality in the organization.

Pollitt (2006) explored the training aiming to improve staff morale and service standards at the Red Carnation, an international group of luxury hotels in London. The company devised a two-tier training program. Ambassadors in Management 1 (AIM 1) trained new supervisors in the skills needed to achieve the Chartered Management Institute certificate in team leading. AIM 2 enabled supervisors with six months’ experience or more to build on the skills to enhance departmental and business goals leading to the Institute of Leadership and Management introductory certificate in first-line management. Among other advantages, training resulted in increased employee motivation and new confidence in the supervisors. The evidence demonstrated a commitment to learning and development from the staff as they felt valued by the company.

Briggs, Sutherland, and Drummond (2007) concluded based on surveys of staff in small, medium, and large hotels; in-depth interviews with a veteran hotelier; and comments on service quality in TripAdvisor that that training and development strategies were essential to counteract staffing problems. Respondents from small and medium hotels suggested that staff was critical to the delivery of service quality and that it was becoming increasingly difficult to attract and retain staff in an environment characterized by lack of training, long hours, and low pay (Briggs, Sutherland & Drummond, 2007).
**Employee Satisfaction and Commitment**

Choi and Dickson (2010) researched the impact of management training programs on employees’ turnover and satisfaction levels. The study was conducted with a lodging company operating two hotels. The results from the study showed that the enhanced quality and rigor of the company’s training programs increased employee satisfaction level and consequently reduced their turnover rate (Choi & Dickson, 2010). Development and implementation of training programs are crucial for the company, as well-trained managers are more successful in hiring and retaining employees who are motivated and eager to improve the organization.

Costen and Salazar (2011) investigated the relationship between training and development, and employee satisfaction with jobs in the context of a lodging property. The study was conducted at a lodging corporation that owned and operated four full-service, upscale, and luxury hotels and resorts in the southeastern United States. The findings suggested that when organizations invested in and developed quality trainings programs, it increased employee loyalty and reduced involuntary turnover. The conclusion of the study was that training opportunities enhanced employees’ confidence in their abilities and satisfaction when it provided them with the necessary skills, knowledge, and abilities needed to perform their jobs to meet company’s standards.

Gu and Chi Sen Siu (2009) found that providing on-the-job training to update and broaden the employee skills by sponsoring their participation in external education programs increased employee job satisfaction and loyalty. A survey was conducted
among Macao Casino Hotels’ employees to determine how job satisfaction may be enhanced to improve work performance. A questionnaire with questions regarding job skills, work ethics, and job satisfaction was designed.

Dhar (2015) researched employees working in an Indian hotel chain that had small- and medium-sized properties and catered primarily to tourists. The author surveyed 494 employees to determine the impact of training received on employees’ commitment levels. The findings of the study revealed that accessibility to training programs offered by the hotel was positively related to employees’ commitment levels. Management’s efforts to make training programs accessible allowed employees to upgrade and develop required skills for the job, leading to a feeling of loyalty towards their organization (Dhar, 2015).

In order to investigate the impact of organizational training on employee commitment Bulut and Culha (2010) conducted field research by surveying 298 participants of four and five-star hotels operating in Izmir, Turkey. The results of the study confirmed that training increases employees’ skills, job performance, and feelings of self-worth. Training also positively impacted employees’ achievement of organizational goals and it made them feel supported by their supervisors or seniors, thus increasing their overall commitment to the organizations (Bulut & Culha, 2010).

In the research study conducted by Buick and Muthu (1997), evidence pertaining to employee training and development practices, including reduction in staff turnover, were identified. Researchers investigated in-house employee training and development practices within hotels in Scotland that have 50 or more bedrooms from an
operation/management perspective. The surveys supported the finding that high staff turnover is a major problem that can be attributed to lack of induction, training, and development.

Roehl and Swerdlow (1999) examined the attitudes of hotel employees regarding the training they received and tested if there was a relationship between training and organizational commitment. A total of 190 employees representing five hotels in the western US participated in the study. All data was collected using a self-administered questionnaire designed to obtain information on organizational commitment and characteristics of the work environment. Training was shown to have a significant direct positive relationship with employee morale, perceptions of supervisor quality, awareness of rules, and a significant indirect positive relationship with organizational commitment. Training was found to improve organizational commitment regardless of the employee’s background.

Lam, Zhang, and Baum (2001) suggested that training and development programs, particularly for newcomers and well-educated employees, will help improve job satisfaction with the job at hand. Based on survey data collected from 288 employees representing five hotels in Hong Kong, results indicated that investing in employee training, especially for newcomers and well-educated employees, improved their skills and knowledge, thus resulting in them being more satisfied, loyal, and committed to the hotels (Lam et al., 2001).

**Reduced Work Stress**
Although no studies have been done specifically in the hospitality context to address how training programs reduced employee work stress, Karatepe and Uludag (2008) found in a study involving Northern Cyprus hotels that employees in frontline service jobs were highly stressed and may not have been capable of carrying out job-related duties effectively due to a lack of training. A total of 42 three-, four-, and five-star hotels were contacted to distribute self-administered questionnaires to frontline employees.

**Employee Preferences for Training Approaches in the Hospitality Industry**

Satisfaction with training and development is a major factor in decisions regarding people’s careers (Violino, 2001). Schmidt (2007) defined training satisfaction as “how people feel about the different aspects of the job training they receive” (p. 483). The global economy of today makes ongoing learning throughout an employee’s career necessary for continued employability. It is important to not only examine job training satisfaction in a broad sense but also delve deeper into the components of training that may make up job training satisfaction for employee’s (Lowry, Simon, & Kimberley, 2002).

Canning (2011) aimed to identify and understand the learning processes of older workers in the hospitality industry in Scotland. Based on 30 interviews conducted with older workers, line managers, and human resources managers, it was found that many older workers preferred on-the-job training and team-based learning approaches, which emphasized interactivity, personalization, and informal learning.
Stevens (1985) studied the difference in preference for a behaviorist versus humanist approach to learning among hospitality managers and executives. An exhibition booth at the National Restaurant Association Restaurant-Hotel-Motel show was used to obtain responses to the Learning Preference Survey from more than 500 industry managers. Results suggested that training programs for younger hospitality managers and executives should be less structured while providing more self-directed learning by a larger number of learning facilitators.

Chiang, Back and Canter (2005) investigated the expectations and perceptions of training quality of hotel managers and employees with the goal of improving training quality and increasing training satisfaction. Researchers developed a three-part questionnaire adapted from the SERVQUAL instrument to assess the respondents’ training satisfaction. The findings suggested that hotels can minimize training dissatisfaction by providing training at the time originally scheduled, requiring managers to support the training, communicating clearly with the employees about the training procedures, adequately training the hotel employees to do their jobs and utilizing up-to-date training tools and materials.

The review article by Harris and Cannon (1995) presented training methods and tools currently used in the hospitality industry and their impact on training delivery. At the property level, executive level hotel training directors and hotel trainers were interviewed to obtain their opinions of the training methods for the future. Results suggested that training should include a variety of methods and tools that are highly stimulating, along with improved programming and communication.
A study by Kim, Erdem, Byun, and Jeong (2011) investigated the use of e-learning for soft skills training, with a focus on hotel employees. E-learning systems were designed to enhance effectiveness and meet the needs of employees of different ages required to manage core processes within the companies. The sample for the study included randomly selected hotel line-level employees, supervisors, managers, and directors. The results suggested that both younger and older employees, who have higher extrinsic motivations in using e-learning, have higher intentions to use e-learning to improve soft skills in the future.

One issue which concerns academics is the question of how to influence, and measure, training effectiveness. Tracey and Cardenas (1996) examined various factors, which can influence the effectiveness of training programs and specially identified individual factors and the work environment as having an influence on training effectiveness. The study was conducted in the dining services division of two small, private colleges located in the northeastern United States. Factors such as instructional sequencing, continuous feedback, and the use of appropriate training methods were vital to effective training. In addition, it was found that if managers understood the value of training, encouraged their employees to attend training, and provided the resources necessary to utilize training, the effectiveness of both formal and informal training programs may be enhanced.

Training Delivery Methods Used in the Hospitality Industry

As the global competition within the hospitality industry is increasing, training programs must prepare employees to be more efficient, effective, and user-friendly.
Even with the growing availability of technology, the majority of the training conducted in hotels still uses traditional classroom-based training as well as the instructor-led methods (Lee & Singh, 2012). Learning styles can be enhanced when receiving training through computer-based delivery, hands-on delivery, interactive sessions, and online or e-learning (Buch & Bartley, 2002). With a higher standard of education and computer competency in today’s workforce, blended learning has become more relevant than ever before (Thorne, 2003). Hotel training programs must be developed as an integral part of hotel management systems but at the strategic and operational levels.

**Traditional Training Methods**

Traditional instruction involves learning in classroom settings, which include lecture and discussion, case studies, and role playing. Additional traditional methods include self-directed learning programs, mentor training, on-the-job coaching, job shadowing, vestibule training, and learning in simulated work setting.

Classroom instruction continues to be the way the majority of training content is delivered in work settings. Classroom instruction includes the use of lecture and discussion, case studies, and role playing (Goldstein & Ford, 2002). Case studies offer an opportunity for learner freedom with less instructor control. The trainer is presented with a case or scenario that depicts a situation to which the trainees apply problem-solving and decision-making skills (Moskowitz, 2008).

There are a number of other types of training programs that professionals can use to engage an employee; most good training programs use a variety of delivery methods (Wilson, 2012). On-the-job coaching is a training method in which a new employee is
assigned to a more experienced employee or manager to learn the skills needed for the job. This is similar to mentor training methods, except that a mentor training method is less about the skills and more about ongoing employee development. Job shadowing is a delivery method consisting of on-the-job training and the employee’s learning skills by watching someone more experienced. Vestibule training delivery, also known as “near site” training, normally happens in a classroom, conference room, or lecture room to deliver orientations and skills-based training (Wilson, 2012).

Active training promotes learning by doing. Experiential learning approaches are suited for affective and behavioral training goals. They help participants become aware of their feelings and reactions to certain issues and new ideas (Silberman & Biech, 2015). An “active” approach to teach is to demonstrate a skill, but with little to no explanation. This process allows the participants to observe the demonstrations carefully and explains what occurred while encouraging participants to be mentally alert. For example, role play is most appropriate to help trainees deal with problems and decisions related to human interactions and relationships. Not only do participants learn from role play, but the audience members also learn by watching the role play to understand what they would do similarly or differently in the situation (Moskowitz, 2008). Training simulations are designed to replicate the essential characteristics of the real work that is necessary to produce learning and transfer (Goldstein & Ford, 2002). An advantage to using games and simulations is that they encourage participants to confront their own attitudes and values. Games and simulations also help test the behavioral style and performance of a participant. Introducing a game at the beginning of a course allows the
trainer to identify the learning styles and skills that already exist and those that need to be strengthened. Playing a game at the end of the course enables the trainer to assess the instructional experience (Silberman & Biech, 2015).

**Use of Technology in Training**

The traditional hotel industry has placed great emphasis on the provision of service quality to guests. With the increasing demand for intensive information from customers and hotel practitioners, hotels have adopted computer-based training to improve operational efficiency, reduce cost, and enhance service quality (Camison, 2000). Noe (2005) identified six levels of technology-based training including: communications, online referencing, testing assessment, the delivery of computer-based training and multimedia, blended learning, and electronic performance support systems. The internet, voice-mail, email, automated room reservation, computerized accounting and financial reporting, computerized food and beverage ordering, interactive guides for guest, cell phones, and electronic credit-card are some examples of information technologies (IT) utilized in hotels (Lam, Cho, & Qu, 2007).

Lee and Singh (2012) explored providing different training approaches for different levels of staff, such as computer-based training (CBT) for managers and classroom training for rank-and-file staff. Questionnaires completed by executives and managers revealed that classroom training is still commonly adopted and strongly preferred over CBT in Hong Kong hotel training. This is despite CBT having been proven to reduce the employee training time, enhance learning, and extend retention, all while improving sales. Hardware and software costs were identified as key obstacles to
implementing CBT. The benefit of classroom training was that it ensured everyone received the same information face-to-face at the same time.

Chan and Choi (2012) continued to research the adoption of CBT in hotels among hospitality management undergraduates. A total of 140 usable self-administered questionnaires were collected. Factor analysis revealed three interpretable factors of undergraduates’ perceptions of CBT: compatibility, effectiveness, and self-efficacy. Researchers discussed how CBT could be utilized in education to help facilitate the acceptance and usage of CBT. For instance, a virtual hotel front office could be designed to let students practice check-in and check-out procedures and complaint handling skills (Chan & Choi, 2012). Students’ “job” performances would be enhanced, thus motivating them to use the technology. CBT could soon be the prevalent method of training in the hospitality industry.

A UK hospitality company Whitbread, which manages hotels, restaurants, and coffee shops, decided to blend e-learning with classroom-based training among 35,000 employees. All current and future employees will have to be trained the “Whitbread way,” which combines the key values of: people and teamwork; caring for guests; passion for winning; and continuous improvement (Pollitt, 2008). Whitbread purchased the el-box, a tablet-style device, which provided flexible learning and allowed employees to maximize their productivity during work hours. Classroom-based learning allowed the employees to work on a live system with a trained tutor and blended with e-learning. This process enabled the students to learn in both a practical and theoretical manner (Pollitt, 2008).
As technological advancements offer enhanced opportunity and flexibility in the way information is communicated and assessed, new mechanisms such as mobile devices are starting to be utilized as training tools (Kim & Kizildag, 2011). M-learning offers both trainers and learners the opportunity to interact and have access to educational material utilizing handheld devices, independent of time and space for employees’ knowledge and performance. Kim and Kizildag (2011) suggested utilizing mobile devices for hotel employee training in the following ways: distributing daily information to employees, deploying new applications, communicating, receiving and sending reports, archiving, sharing meeting materials, and making conference calls. For example, many hotels in Las Vegas have more than 3,000 rooms with more than ten different room types. Employees can utilize their mobile devices to watch video clips showing the standardized process of making each room, furthermore decreasing the training costs while increasing the service quality (Kim & Kizildag, 2011). Housekeeping, room service, restaurant, and other customer-service sectors were suggested as good areas to use mobile devices for training.

**Effectiveness of Training Methods Used**

The goal of any training program is to impart to individuals a new set of skills, knowledge, behaviors, or attitudes (Goldstein, 1993). As innovative training methods have become available, an increase in effectiveness and efficiency of training delivery, employee performance, and customer service have been reported throughout the hospitality industry (Harris & Cannon, 1995). Some organizations have taken a leadership role in providing a more educational, individualistic approach to training by
improving training program design and using computer technology (Harris & Cannon, 1995).

Perdue, Ninemeier, and Woods (2002) assessed how 123 private club managers, who were members of the Club Managers Association of America, perceived the relative effectiveness of alternative training methods to attain specific types of training objectives. Participants rated the effectiveness of 16 alternative training methods for potential use in six different types of training situations. Training methods included case study, video-tape, lecture, one-to-one, role play, games, computer simulations, paper and pencil, audiotapes, self-assessment, movie/films, multi-media audio conferences, sensitivity training, and computer-assisted instruction. The results indicated that club managers believed that some methods are better for specific training objectives than others. For example, one-to-one training, which was rated extremely useful for knowledge acquisition, was found to be more useful for knowledge retention. Sensitivity training was found to be the most useful method for interpersonal skill development. This training was also the preferred method for changing attitudes and the third most popular choice for knowledge retention. Respondents with differing years of experience and education were suggested to have similar beliefs about the use of alternative training methods.

Furunes (2005) assessed how hospitality managers perceived the relative effectiveness of alternative employee-training methods to attain specific training objectives. Data was obtained from 56 hotel managers in member organizations of the
Norwegian Hospitality Association. Participants rated the effectiveness of 15 training methods for prospective use in six training situations. The results indicated that one-to-one training was perceived as the best training method across five of the six objectives. For interpersonal skill development, role-play was perceived to be better than one-to-one training.

Frash, Antun, Kline, Almanza (2010) conducted a field study of a major international hotel company’s training program to explore the factors influencing employees’ ability to transfer job training. The training objective was to ensure employees’ had the knowledge and skills needed to operate a new property management system (PMS) in 25 hotels throughout the United States. Role-playing exercises and surveys were used to explore the validity of the research. At the conclusion of the training, the associates took a final exam that required the trainee to demonstrate competency with the new PMS. This study suggested that trainee characteristics, training design, and work environment factors positively impacted and enhanced an employee’s transfer of training. Hotel associates’ felt that doing well in training would improve performance and be rewarded. It was recommended that training managers should build the motivation to transfer what was learned during training by using realistic exercises to connect the training to performance.

Hand Picked Hotels, a collection of 17 country-house hotels, aimed to enhance the brand and internal culture through the delivery of experiential training modules developed around key behaviors for all team members at hotel and support centers (Pollitt, 2011). Learning was delivered through five modules including: facilitated
discussions; games and role-play to explore the behaviors and their impacts; practical challenge to be undertaken between modules; and personal-development plan to focus on one key behavioral aspect per module to improve service or relationships. A campaign named Being Hand Picked involved 32 support-center employees attending in-group training and a two-way workshop to learn the program. Training resulted in a number of benefits including: (a) an increase in loyalty-club memberships; (b) improvement in employment retention from 47% to 61%; and (c) reduction in customer complaints by 40%.

Multimedia systems can be the solution to enhancing performance effectively and efficiently by accelerated learning in the lodging industry. McDonald (2004) examined the training process developed by Holiday Inn Worldwide for the implementation of a new information system. A total of 826 employees were split into 2 primary groups: trainees receiving training on a new information system consisting of traditional methods and trainees using a multimedia CDROM of the same system. While utilizing standardized tests, individual performance was measured on employees’ knowledge of the new information system. The results indicated the attitudes of employees were significantly improved in the traditional approach given that employees received extra attention heightening self-efficacy.

Maier and Thomas (2013) conducted a study to compare student perceptions of training classroom-based course design and delivery with blended-experience course design and delivery. The longitudinal pilot study was designed and delivered in the hospitality school of a private 4-year institution spanning two academic years. The
course was evaluated based on traditional classroom-based delivery in Year 1 and blended-experience delivery in Year 2. Students were introduced to leadership and team performance theory with Kolb’s experiential learning approach embedded into the hotel market. The learning-based management system utilized Desire to Learn (D2L). SoftChalk software was built and it delivered course content through integration of experiential learning-based pedagogy. The results indicated that a majority of students agreed that course design, effectiveness, participation in experiential learning activities, and acquisition of real-world business experience impacted the success of their online learning experience. Maier and Thomas (2013) found blended-experiential learning method to be helpful for developing deeper comprehension of real-life business scenarios in the area of leadership and team performance.

**Role of Training Professionals in the Service Industry**

Whether training is done in the classroom or in simulated environments, designers and trainers must consider instructional factors to make sure that the instruction given is effective (Goldstein & Ford, 2002). Effective instructors have high expectations for trainee learning and make efficient use of instruction time. For example, the instructor should (a) know what outcomes are to be achieved in a given period of time; (b) organize instruction around these outcomes; and (c) adhere to the learning goals in the face of distractions. Effective instructors also engage learners in the learning process (Moskowitz, 2008).

Training professionals are an important asset for hospitality operations because they are responsible for providing formal and informal learning to new and existing
employees in their department (Kalargyrou & Woods, 2011). As a facilitator of learning, training professionals focus on promoting, guiding, enabling, and supporting learning in order to achieve learning organizations that reinvent not just their organization, but also their industry (Hayes & Zaccarelli, 1996). Training professionals need to be skilled in the four management functions: (1) planning, from conducting a needs assessment, to designing a program, to measuring outcomes; (2) organizing the two main components of an organization, structure, and people; (3) directing, which encompasses leading, communicating, supervising, and motivating and (4) controlling, which ensuring that the training plan is effectively performed (Kalargyrou & Woods, 2011).

The role of the trainer can make the difference between a successful or unsuccessful learning experience. The role of the trainer was explored by Watkins (1990) in interviews with fifty-seven human resource developers at a government agency, a high technology corporation, and a research hospital. The research explored the trainers’ beliefs and discovered three themes: training is something with which one is born; training is political; and training is learning. People from the first theme see skillful training as amazing, magical, and something out of reach. People who view training as political believed the training staff is where organizations put misfits who cannot do anything else. Individuals who believe training is learning, focus on learning as a way of being responsive to organizational needs. These individuals continuously reflect on their practices and engage in self-learning.

Towler and Dipboye (2001) investigated the impact of trainer expressiveness and organizational and trainee goal orientations on the recall of problem solving, and
motivation of the trainee. Using a three-factor experimental design, 142 undergraduate students from a private university in the southern United States completed recall and problem-solving tests immediately after training and 2 days after training. The findings showed that if the objective was to either enhance memorization or induce trainee motivation, trainers should strive to be both organized and expressive in their delivery. The importance of the trainer’s delivery and the trainee’s motivation may be more apparent in an oral delivery than when participants read written textual material without being able to see or hear the author of the text.

**Training Evaluation**

Kirkpatrick’s model of training effectiveness (1998) is still the most prevalent framework for categorizing training criteria (Alliger, Tannenbaum, Bennett, Traver, & Shotland, 1977). Kirkpatrick’s taxonomy consists of four hierarchical levels: reactions, learning, behavior, and results. The lowest level, reaction, is a measure of customer satisfaction; learning, the second level, refers to a change in attitude or increased knowledge and/or skill development; the third or behavioral level indicates the application of learning to the workplace in the form of new or different behaviors; and the fourth level focuses on the results attributable to the participants who attended training (Weaver, Park, & Clemenz, 2005).

The ROI methodology (Phillips, 1997) is a step-by-step process tool for evaluating any program, project, or initiative within any organization. The ROI process adds a fifth level to the four levels of evaluation that Kirkpatrick (1974) developed. The concept of different levels of evaluation is both helpful and instructive in understanding
how the return-on-investment is calculated. The five-level framework consists of reaction and planned action, learning, job applications, business impact, and return-on-investment (Phillips, 1997). Four specific elements of the evaluation process must be explained when developing the evaluation plan for an ROI calculation. The four elements: evaluation purposes, instruments, levels, and timing are all considered when selecting the data collection method and developing the data collection plan.

Frash, Kline, Almanza, and Antun (2008) explored the hierarchical connections between Kirkpatrick’s first three levels of training evaluation to help predict outcomes from higher levels of training evaluation. To facilitate the research, a major international lodging organization’s training intervention was utilized. Level 1, reactions, were measured using a standard smile-sheet survey at the conclusion of the training. Level 2, learning, was measured by “final certification-activity,” and level 3, transfer, was assessed through a role-play-type transfer activity. The evidence suggested that the more the participants liked the training, the greater the learning outcome was, increasing transferring of training. The three levels of assessments proved to be positively correlated as the hotel made a significant fiscal investment in the evaluation of the participants’ reactions, learning, and transfer.

A recent study by Ho, Arendt, Zheng, and Hanisch (2016) explored the practices and perceptions of hotel managers in training evaluation using Kirkpatrick’s and Phillips’s models. A total of 6 hotel managers completed in-depth interviews and paper-based questionnaires were sent to managers of hotels with more than 30 rooms in a Midwestern state. The findings of the study indicated that hotel managers rated
observation as the most important and most frequently used method to evaluate training. The findings also provided researchers with more insight into how hotel managers evaluate their training and what a practical process should possess.

By examining a sample of four- and five-star hotels’ employee training and development (T&D) policies and approaches, Wang (2011) developed an evaluation tool for China’s hotels. Multiple case-studies were chosen as the main method for data collection to obtain a richer understanding of the key issues of employee training, management development, and learning. The tool evaluated eight high-star-rated hotels in China and compared the results between Chinese state-owned and Sino-foreign joint-venture hotels. The study found that with more exposure to modern Western management theories, the T&D practices in the studied foreign-invested joint-venture case hotels tended to be more systematic than that in most of the Chinese state-owned case hotels, which tended to be more completed and consistently operated. The designed T&D evaluation tool was proven to be applicable and useful to help enable Chinese hotels be aware of existing gaps and make improvements with the human resource development standards.

Haywood (1992) studied the need for adopting a more-effective way of developing and evaluating training programs in two Canadian hotels. By analyzing the training-program success of the Prince George Hotel and the Edmonton Inn, Haywood (1992) established an evaluation system to measure and communicate the effectiveness of training and assess the commitment of all participants. It was found that the use of guest evaluations and performance reviews were effective in determining whether what an
employee learned in the training sessions was carried over to actual job activities. The author did caution that when evaluating the outcome of training, it is necessary for organizations to create their own indicators.

**Training Younger Generations of Hospitality Employees**

As workforces are becoming progressively more diverse in race, gender, ethnicity, and generation, the workplace has become more challenging for HRM practitioners (Zemke, Raines, & Filipczak, 2000). Work-related characteristics and attitudes of younger generations are radically different from those of previous generations entering the work force (Solnet & Hood, 2008). Technological and collaborative experiences that exhibit clear goals, enhance motivations, and involve authentic activities have been shown to be preferred by younger generations. They expect online learning with interactivity, visual effects, and rapid access to information (Wood, 2011).

**Training the Millennial Generation**

Millennials are best described as confident, hopeful, civic-minded, inclusive, and connected (Glass, 2007). Millennials, also referred to as Generation Y, Nexters, and the Net Generations have been described as a challenging group to recruit and manage (Werth, 2011). Millennials grew up with technologies such as cell phones, internet, blogs, e-mail and other forms of information age media. The unique characteristics of Millennials are: highly optimistic, idealistic, conventional, high expectations of self, and goal driven (Chen & Choi, 2008). Given these generational attributes, a training program must be tailored to match Millennial learning styles and conventions.
Werth and Werth (2011) provided training administrators and educators with concrete suggestions on how to effectively facilitate the learning of Millennial generation students. Today’s students are expected to build relationships, think proactively, work with a variety of entities to identify needs, and utilize available resources in a multifaceted problem-solving process. Educators must not only seek out training in the practices that hold potential in reaching Millennial students, but they must also be willing to accept new pedagogical approaches as they strive to make improvements in their courses.

In his book, Sheahan (2005) provided a definitive guide to training Generation Y in the workplace. Gen Y are characterized by their impatience due to over-stimulation caused by media and technology. Their impatience manifests in forms including: ambition, being constantly on the lookout for something better, delusions of personal ability and competence, desire to be involved in workplace process design and execution, yearning for instant gratification, and a need for instantaneous communication and feedback (Sheahan, 2005). He argued for training to be effective for Gen Y, it must be relevant, interactive, personalized, and entertaining.

In order to understand Millennials’ preference for learning, Stratton and Julien (2013) created an innovative group project that challenged undergraduate human resource management students to integrate Xtranormal (test-to-video software) into a role-play exercise. Xtranormal provided tech-savvy Millennial generation students with opportunities for active learning and theory application central to the project’s core learning objectives (Stratton & Julien, 2013). Student learning data were collected over
the course of three semesters from 210 students. Feedback from the students suggested that the use of Xtranormal resulted in a number of learning outcomes, including creative freedom that enhanced engagement with the material, greater understanding and application of concepts, and training method and design competency.

To train Generation Y with effectiveness, businesses must embrace mobile and social technology, and let go of outdated notions of workplace education. According to a report from UNC’s Kenan-Flagler Business School, Gen Y will make up 46 percent of the US workforce by 2020 (Lye, 2014). A company must create entertaining video lessons that are no longer than three minutes to ensure the learning modules are more engaging and accessible than dense text. In the process of developing great educational models, companies should use popular media as models will focus on Millennial subjects that can accelerate training and develop in a more effective workforce (Lye, 2014).

Togonu-Bickersteth (2014) investigated hospitality millennial students’ perceptions about preferred teaching and learning methods that will enhance their learning. Questionnaires and focus group discussion were used to collect data from groups of students from the only Hospitality Monotechnic in Nigeria. The study confirms several significant issues arising from millennial students as they value technological driven teaching methods mixed to an extent with traditional based methods. The students view that traditional classroom lecture is often not effective as it fails to hold their attention.

Correia, Arendt, Strohbehn, and Meyer (2012) described the idea behind the design and development of a responsive design website to train foodservice Millennial
employees on safe food handling practice. As a result, a responsive design website – *Do Your PART: Plan, Act, Routine and Think* – was designed, developed, and tested on a smart phone to the Millennial generation in both English and Spanish-speaking groups. The application offered three instructional components: watch an instructional video, practice what is learned, and check what is learned. The training on the smart phone adaptable website aimed to increase foodservice employees’ knowledge and skills to complete their PART in handling food in a safe manner.

**Training Generation Z**

Generation Z consists of people born since 1995; they are also referred to as Gen Z, Children of Internet, Digital Generation, Digital Natives, Media Generation and iGen (Levickaite, 2010). Currently, Gen Z comprise about 7% of the workforce; however, by 2019 it is estimated that 30 million will be employed (Jacoby, 2015). Gen Z react to highly defined small workgroups that have a strong peer leader. A company must invest in training, especially in the area of interpersonal and communication skills if they are entering customer service positions. Gen Z workers thrive on opportunities. To keep this generation interested and motivated, a company must show them their dream position is within the current business of employment (Jacoby, 2015).

Generation Z, the children of the Xs, are a complete technology-based generation as they were born into technology rather than being accustomed to it (Berkup, 2014). The most distinctive traits of Gen Z are reliance, freedom, individualism, addiction to technology and speed. The most distinct traits are socializing through internet, consuming rapidly, practicality and speed, interactivity, efficiency, dissatisfaction and
being result-oriented. Generation Z are expected to have working characteristics such as multitasking, efficient technology utilization, individualism, creativity, global point of view and preference of non-standard and personalized works (Berkup, 2014). Compared to the previous generations, generation Z started to be educated at an earlier age and received a developed and planned education.

According to a recent 2015 “Way To Work” survey by Adecco Staffing USA, 32% of Gen Z are focused on finding their dream job within 10 years from now (Crouch, 2015). Today’s students report finding a job as their top concern as the rise of student debt associated with the cost of education and the lasting financial impact on their future. Nearly 83% of today’s students believe that three years or less is an appropriate amount of time to spend at their first job. By providing effective and frequent training, as well as professional development opportunities, employers can help their employees maintain a high level of engagement and retention within the company (Crouch, 2015). Job shadowing is another great way to provide these employees with well-rounded training. Allowing employees to shadow colleagues in other departments, can help them learn new skills and gain a greater understanding of the company as a whole to encourage growth from within (Crouch, 2015).
CHAPTER III
METHODOLOGY

A manual is defined as a book of information or instruction, designed to improve the quality of a performed task (Tonge, 2010). The objectives of any information or instruction writing project are to motivate the end-user to read, understand, apply, and remember the information (Tonge, 2010). A well-written training manual sets forth the expectations for the employees, and describes what is expected from the company (Davis, 1992).

Before composing a training manual, the organization should complete a front-end analysis, divide the contents needed for training into modules, and select an appropriate style manual (Davis, 1992). By completing a front-end analysis, a task list of terminal and enabling objectives for the cognitive and behavioral tasks will be created within the training manual (Lanigan, 2012). The task listing will guide the outline of the training manual in the sense that all pre-requisite skills should be presented before more advanced skills (Lanigan, 2012). After outlining the content of the training, the content is divided into modules or chapters containing specific information. Selecting an appropriate style manual will guide the process on how to present the information to ensure the training manual looks consistent (Lanigan, 2012).

There are three main steps to creating training manuals: (1) writing the draft manual; (2) editing the draft manual; and (3) finalizing the training manual. When writing the draft manual, the information needs to be grouped into shorter sections and the sections should be connected with transitions in logical order (Lanigan, 2012).
Trainees can be overwhelmed by huge amounts of text grouped together. Incorporating effective transitional statements between paragraphs will help the trainees understand how the training process is moving from one idea to the next (Davis, 1992). For example, in the study by Pollitt (2011), the Hand Picked Hotels delivered learning through five modules that included: facilitated discussions, games, and role-playing to explore the behaviors and their impacts; a practical challenge to be undertaken in the period between modules; and a personal-development plan to focus on one key behavioral aspect per model to improve service.

In addition to grouping and transitioning the training material, it is important to make sure the writing is easy to read, leaving white space between paragraphs of ideas and other logical groups (Lanigan, 2012). White space makes the material look less intimidating (Lanigan, 2012). Using images to enhance the communication of the message or process will help trainees understand and visualize the information (Davis, 1992). A quality training manual provides the trainees with a number of exercises and/or practices to reinforce the materials they are learning (Tonge, 2010). As an example of an application of this in the hospitality industry, the training director of the Richford Inn developed a number of exercises based on the emergency situations that could arise during the manager on duty’s (MOD) shift (Berger & Farber, 1986). The MOD trainees rehearsed their responses via role plays.

Editing the draft manual involves making sure the content is accurate, clear, and comprehensive (Davis, 1992). Trainees need to understand what is being communicated to understand the training policies and procedures for success. After editing the manual
numerous times, the next step would be to test the material on people who are like the trainees to ensure the manual is fully functional (Lanigan, 2012). To finalize a training manual, introductory materials of the training manual such as the title page, company logos, publisher and copyright page, and table of contents should be included (Lanigan, 2012).

Training handbooks and manuals are only as effective as the manner in which they are presented (Davis, 1992). Lanigan (2012) stated that writers must use relevant terminology and make assumptions about what needs to be explained and what is considered obvious. Noe (2005) also emphasized that it is necessary to establish training programs to meet the needs of different audiences. Utilizing technology in training allows trainees to learn at their own pace and makes better use of their time, thus accommodating individual differences in learning (Lee & Sing, 2015). In a study by Kim, Erdem, Byun, and Jeong (2011), while exploring the use of e-learning in hotel training, the researchers found that learners who have higher extrinsic motivations towards using e-learning were more likely to use the training tool.
CHAPTER IV

THESIS PROJECT

Training manuals serve the important purpose of providing a consistent way to communicate instructions to employees about how to perform essential functions of their jobs (Noe, 2005). Supervisors could also benefit from clearly established training manuals as the document could provide the necessary information to train new hires and to manage the performance of incumbent workers (Lanigan, 2012).

To prepare the front desk employee manual for the independent boutique hotel that was part of this project, the researcher met with the hotel’s management team to review the current hotel policies and training material. It is to be noted that some of the information provided related to the management company that managed several chain and independent lodging properties as opposed to the specific independent boutique hotel. It was imperative to change the material in order to reflect the unique core values and principles of this specific boutique hotel.

When reviewing the content, decisions were made as to which policies were fundamental, which ones needed adjustments, and which ones needed to be removed. As Noe (2005) suggested, the training manual content should be broken down into small units including topics, tasks, procedures, and other information arranged in a logical sequence to allow trainees to master the material within in the manual.

The manual was broken down into 17 main sections followed by multiple subsections. Using a table of contents with section indicators rather than just page numbers made the manual easy to update and follow. Each new section began on a new
page, leaving room for future adjustments if necessary. The manual started with a section
to welcome the new employees and introduced the hotel’s mission and vision, and
amenities available at the hotel. Names and contact information of the hotel management
team were also included. Other general hotel information included airport locations,
directions to area attractions, guest services, meeting room types, and hours of the
restaurant operation within the hotel. Headshots of the hotel management team,
foundation board, and other important personnel were used to help trainees remember the
names as they are expected to greet each person by name when they come into the hotel.

The job description of each position was included in the manual to describe the
purpose, duties, responsibilities, tasks, and relationships of a particular job. While every
position changes somewhat over time based on the abilities of the incumbent, the
description should be written to reflect the responsibilities of the position itself as
opposed to the capabilities of any individual (McClelland, 1995).

The front desk reservations section included several step-by-step processes
describing everything from making a reservation, checking-in and checking-out a guest,
collecting payment, and making restaurant reservations. The section also included
examples of scripts that a front desk agent should use while checking-in a guest and
booking in the computer system. The hotel’s management team strongly desired that
each topic be explained in detail as opposed to including simple checklists. Hence, bullet
points were avoided. The day-to-day training guide was the only section utilizing a
check-list style, as it is a guideline for the supervisor to follow when training new hires.
The section on hotel billing and payment included information on cash deposits, debit cards, petty cash, adjustments, trade-out procedures and cash drawer procedures. This section was followed by steps for selling and redeeming gift certificates and Portage Area Regional Transportation Authority (PARTA) parking. The section of PARTA parking specifically explained validation and parking charges per guest.

Hotel policies and procedures were expanded to include requirements specific to the hotel. Information regarding uniforms, department organization, cash drawers, privacy policies, and breaks and meal periods were added. The department organization section discussed the use of bulletin boards and workspaces in the hotel. The “Business use only” policy advised employee that computers and phones were provided for business use, and any personal use must be kept to a minimum and must not interfere with work responsibilities.

In order to maintain a high level of security in all areas of the hotel, management had to have a solid key control program and guidelines in place. The section that discussed this in the handbook included the fundamental components of a Well-managed key control program. This program was broken down into three section: implementing property key control, front office key control, and maintenance and housekeeping key control.

A chart was used to illustrate the hotel rewards program and member benefits so the front desk agent can help guests to start earning points for each stay. The loyalty program is free to join and will allow the guests to earn points that they can redeem for free nights while the front desk agent receives points for each guest who signs up.
Although the manual was specific to the front desk, the hotel safety and security emergency plan was developed and included in the training manual so employees could refer to it in case of serious emergencies. This section was broken down into front desk specific topics including guest room security, night audits, and panic buttons and general hotel procedures to be followed for crisis communication, specific weather emergencies, and evacuation. The hotel that served as a case for this project is located in the heart of a recently renovated and vibrant downtown area in a campus town. Hence, a downtown and local area directory guide were created to provide guests with information on places to eat (categorized by dining style), shops, places to see, popular sporting venues, and local churches.
CHAPTER V
RESULTS AND DISCUSSION

The overall goal of this research project was to create a training manual for front office operations of an independent boutique-style hotel in a campus town in the Midwest. Existing research has shown that hotel managers are reluctant to invest in proper training programs for their employees due to tight budgets and high turnover (Chow, Haddad, & Singh, 2007). One way lodging organizations can increase employee loyalty and reduce involuntary turnover is by investing in and developing quality training programs (Costen & Salazar, 2011).

Employees consider the opportunity to develop new skills an important factor that influences not only their satisfaction with their current job, but also their satisfaction with the company. Being provided the opportunity also positively influences an employee’s loyalty to the company and their intent to remain with the organization (Costen & Salazar, 2011). Hotel executives and managers should partner with the human resources department to promote the various training opportunities that are available in the company. Furthermore, hotel managers should ensure that all employees receive formalized training that help them learn the essential components of their jobs, and the company standards associated with successfully performing their jobs (Costen & Salazar, 2011).

A review of professional hospitality and business articles on training and other resources revealed that experts perceived a strong correlation between training and many other factors including increased employee job satisfaction, commitment, service quality
and length of employment (Conrade & Woods, 1994; Wesley & Skip, 1999; Chiang, Back, & Canter, 2005). However, a gap exists between the academic literature and what practitioners are actually implementing when it comes to training employees in the lodging industry.

Training seems to be high on the priority list of academics in the hospitality field (Clements & Josiam, 1995). According to Harris and Cannon (1995), training methods and tools, which have been utilized to enhance or communicate training subject matter, can greatly affect the effectiveness of training programs. Methods and tools such as lecture-to-group, on-the-job training, and videotaped training programs, have been used by the hospitality industry for many years. This is despite the fact that these methods and tools are not very effective for some positions due to their ineffectiveness in communication and their non-innovative nature (Kim & Kizildag, 2011; Harris & Cannon, 1995; Tracey & Cardenas, 1996). It is important to remember that individuals learn through all five human senses (Buick & Muthu, 1997). Training programs relying on traditional techniques and skills of trainers do not address the diverse learning styles and could potentially limit the effectiveness of an organization’s performance (Buick & Muthu, 1997).

Training techniques and tools in the hospitality industry have experienced drastic changes over the last decade (Lee & Singh, 2015). There has been growing evidence that hospitality companies are not using information technology (IT) strategically or not reaping the benefits appropriately for the substantial among of money being invested in IT (Piccoli, 2008). The investment in IT benefits the hotel if it enables customers to have
a better experience and the hotel staff to work more efficiently to better assist customers (Law & Jogaratnam, 2005). Olsen and Connolly (2000) argue that the use of IT can place knowledge and information at the core of a hospitality organization’s competitive profile. Frew (2000) further emphasized that technology will bring about a major revolution in the hospitality industry.

The hotel industry has been referred to as information-intensive; however, prior studies have indicated that hotels do not always intend to take the lead in implementing a new kind of technology (Cho & Olsen, 1998; Sheldon, 1997). High profile and “high-tech” services have become a requirement for demanding and sophisticated hotel guests. A new challenge for hotel managers in the 21st century is how to integrate the new, complex, and varied services and IT systems into their existing business operations (Law & Jogaratnam, 2005). The idea of innovative training seems to be the latest trending desire in the hospitality industry. Nevertheless, most hotels do not seem to be in favor of adopting advanced software technologies such as systems in assisting with daily business operations. Law and Lau (2000) stated that the low technical competence of hotel managers and the large scale of IT-assisted hotel operations mean that the hotel industry will remain at a high risk of having IT problems.

It is important for hoteliers to proactively incorporate IT into their efforts to improve service quality. IT capabilities are limited more by the hotel management’s attitude, training, skill, ambition and financial situation rather than by the technical limitations of hardware and software systems (Law & Jogaratnam, 2005).
Future of Training Research in the Hotel Industry

As a labor-intensive industry, it is also assumed that technology is applied in the hotel industry’s labor management practices, especially regarding employee training (Lee & Singh, 2016). Despite the assumptions, there is little evidence to support the extensive adoptions of computer-based training by the hotel industry. Billions of dollars are spent yearly on employee training. However, not all training dollars are well spent. Research has shown that employees are more responsive to some types of training than to others (Tan, Hall, & Boyce, 2003). Thus, it is imperative to study the necessary competencies training professionals must demonstrate to perform training that is perceived as effective by employees (Kalargyrou & Woods, 2011). Studies have also emphasized good communication skills, flexibility, enthusiasm, passion and pride, as important ingredients of training (Clardy, 2007). Extensive research has been conducted on designing and conducting training programs, and why training is important to the advancement of organizations; however, little has been conducted on the actual facilitators and providers of the training (Kalargyrou & Woods, 2011).

Hotel managers need to understand what employees want or expect, and how the hotel’s training program is perceived in order to improve the training program (Chiang, Back, & Canter, 2005). Little empirical research has been conducted on the evaluation of training quality. Although a substantial amount of literature has been written about training, there also has been no assessment of the impact of training quality on subsequent behavior or employees’ intention to stay at or leave the job (Chiang, Back, &
Training that is devoted to improving knowledge, skills and attitudes would encourage employees to be more satisfied with their work and to stay at the hotel. The knowledge and skills possessed by an organization’s workforce is becoming more and more important to its competitiveness. Workplace learning and continuous training are considered essential for an organization to remain competitive (Salas & Cannon-Bowers, 2001). Training offers significant contributions to any organization in enhancing the abilities of their employees (Buick & Muthu, 1997; Harris & Cannon, 1995; Aguinis & Kraiger, 2009). Potential benefits have been identified, though in the process it has been recognized that these benefits are rarely realized to their full extent.
APPENDICES
APPENDIX A:

FRONT DESK MANUAL
Appendix A

Front Desk Manual

FRONT DESK MANUAL

Kent State University Hotel & Conference Center

2016

215 South Depeyster Street
Kent, OH 44240
Phone: 330-346-0100
Fax: 330-346-0111
www.kentstatehote.com

A hotel worth of the Kent State name
# TABLE OF CONTENTS

I. ABOUT THE HOTEL .................................................................................................................. 2

II. HOTEL INFORMATION ........................................................................................................... 3

III. PEOPLE TO KNOW ............................................................................................................. 4

IV. KSUHCC JOB DESCRIPTION OVERVIEW ......................................................................... 6

V. FRONT DESK RESERVATIONS

   Check-In Process .................................................................................................................... 8
   Magic Formula ....................................................................................................................... 9
   Making a Reservation ........................................................................................................... 9
   Check-Out Process ............................................................................................................... 10
   Concierge Service: Wow Factors .......................................................................................... 10
   Denials ................................................................................................................................... 11
   Restaurant Reservations ..................................................................................................... 12
   Guest Request ..................................................................................................................... 13

VI. HOTEL BILLING & PAYMENT

   Cash Deposits ....................................................................................................................... 14
   Debit Cards .......................................................................................................................... 15
   Petty Cash ............................................................................................................................ 15
   Adjustments ......................................................................................................................... 15
   Trade-Out Procedures ......................................................................................................... 17

VII. PARTA PARKING

   Insert Parking Charge ......................................................................................................... 18
   Parking Validation ................................................................................................................. 18

VIII. GIFT CERTIFICATES

   How to sell a Gift card ......................................................................................................... 20
   How to redeem a Gift card .................................................................................................. 21
   Paper Gift Certification ..................................................................................................... 21

IX. FRONT DESK SAFETY & SECURITY

   Guest Rooms ......................................................................................................................... 22
   White Panic Button ............................................................................................................ 22
   Night Audit .......................................................................................................................... 22

X. FRONT DESK GUIDELINES

   Department Organization ..................................................................................................... 24
   Cash Drawer ......................................................................................................................... 24
   Flashmart ................................................................................................................................ 25
   Safe Deposit Box ................................................................................................................ 26
   Staff Areas & Use in the Hotel .......................................................................................... 27
   Uniforms .............................................................................................................................. 27
   Front Office Log .................................................................................................................. 28
Maintenance Log ................................................................. 28
Down Time To-Do List .......................................................... 28
Receiving Shipments ............................................................ 29
Nighttime Amenities ............................................................. 30
Shift Close ............................................................................ 31
Medical Emergency Procedure ............................................. 31
Lost & Found ......................................................................... 32
Service Corridor and Meeting Space ....................................... 33

XI. PROPERTY KEY CONTROL PROGRAM ................................ 34
XII. ROOM TYPES ................................................................. 45
XIII. STASH HOTEL REWARDS ............................................. 46
XIV. INNQUEST ROOMMASTER PRACTICE ............................. 48
XV. KSHCC SAFETY & SECURITY ........................................... 53
XVI. FRONT FESK DAY TO DAY TRAINING GUIDE ................. 77
XVII. DIRECTORY ................................................................. 80
Welcome to the Kent State University Hotel & Conference Center

Mission

The Kent State University Hotel
“Your Hotel,”
Where Kent State University Worldwide Family come to Meet, Stay, Play, Dine and Work

Vision

H  Hospitality
O  Outstanding
M  Memorable
E  Enjoyable

ABOUT THE HOTEL

With a prime location adjacent to the Kent State University Campus, the KSU Hotel offers visitors to Kent the most convenient and high class lodgings in the area. Boasting custom, hard-crafted furniture and a sleek design aesthetic, we’re not your run-of-the-mill branded property, but rather a boutique hotel specifically created to provide an extraordinary experience for Kent and Kent State visitors and aficionados.

Amenities

- Superb Dining and Bar facilities featuring our Fabulous Nineteen 10 Restaurant and Lounge
- Room Service
- 94 spacious boutique-style guest rooms with iPad/iPhone docking station
- Refrigerator and microwave
- Coffeemaker with Starbucks™ coffee and tea
- Heated indoor pool and whirlpool fitness center
• 24-hour convenient FlashMart
• Self-laundry
• Complimentary Wi-Fi in lobby and guest rooms
• 5,000 square feet of conference and event space
• Onsite and offsite catering
• Complimentary light continental breakfast
• Stash Rewards & Frequent travel programs
• Convenient Parking
**HOTEL INFORMATION**

General Manager: Michael Riccio  
mriccio@kentstatehotel.com
Director of Sales: Teresa Kirkland  
tkirkland@kentstatehotel.com
Food and Beverage Manager: Eric Little  
elittle@kentstatehotel.com
Sales and Catering Manager: Sage Culley  
sculley@kentstatehotel.com
Operations Manager: Theresa Lamboy  
tlamboy@kentstatehotel.com

<table>
<thead>
<tr>
<th>DIRECTIONS</th>
<th>GENERAL HOTEL INFORMATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>From South: Take 77N to 76E towards Youngstown. Exit 33 for OH43 towards Kent. Turn Left. Turn Right on OH59. Turn Left on S. Depeyster.</td>
<td>Number of Suites 4</td>
</tr>
<tr>
<td>From North: Take Rt. 8 South to Exit 8/Graham Rd. Left on Graham. Graham turns into Fairchild. Right on Water St. Left onto Erie St. Hotel on Left.</td>
<td>Number of Floors 4</td>
</tr>
<tr>
<td></td>
<td>King 42</td>
</tr>
<tr>
<td></td>
<td>King ADA 3</td>
</tr>
<tr>
<td></td>
<td>2 Queen 44</td>
</tr>
<tr>
<td></td>
<td>2 Queen ADA 1</td>
</tr>
<tr>
<td></td>
<td>Executive Suite 3</td>
</tr>
<tr>
<td></td>
<td>(1ADA)</td>
</tr>
<tr>
<td></td>
<td>Presidential Suite (ADA) 1</td>
</tr>
<tr>
<td></td>
<td>Connecting Rooms 8</td>
</tr>
<tr>
<td></td>
<td>218, 219, 220, 221, 318, 319, 418, 419</td>
</tr>
<tr>
<td></td>
<td>Check-in Time:</td>
</tr>
<tr>
<td></td>
<td>Check-out Time: 11am</td>
</tr>
<tr>
<td></td>
<td>Refrigerator and microwave in each room</td>
</tr>
<tr>
<td></td>
<td>Complimentary High Speed Internet Access</td>
</tr>
<tr>
<td></td>
<td>100% Smoke Free</td>
</tr>
<tr>
<td></td>
<td>Lobby locked 11pm-5am</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>AIRPORT INFORMATION</th>
<th>ADDITIONAL GUEST SERVICES</th>
<th>TAXES</th>
</tr>
</thead>
</table>
| Cleveland International <CLE>  
216-265-6030  
42 Miles NW of Hotel | 24hr Business Center |
| Akron-Canton <CAK>  
330-896-2385  
25 Miles SW of Hotel | Indoor Salt Water Pool |
| Hotel does NOT provide transportation | On-Site Guest Laundry |
| | 24hr Fitness Center |
| | On-Site Restaurant/Lounge |
| | Room Service |
| | 24hr Flashmart |
| | State 7% |
| | County 6% |
| | Total 13% |

<table>
<thead>
<tr>
<th>MEETING ROOMS</th>
<th>Nineteen 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meeting Room</td>
<td>Breakfast M-F 6:00am-10:00am</td>
</tr>
<tr>
<td>5050 sq.</td>
<td>Sat. &amp; Sun. 7:00am-11:00am</td>
</tr>
<tr>
<td>Board Room with 10 Chair</td>
<td>Lunch Daily 11:00am-2:00pm</td>
</tr>
<tr>
<td>Dix</td>
<td>Dinner Daily 5:00pm-11:00pm</td>
</tr>
<tr>
<td>Kent</td>
<td>Room M-F 6:00am – 10:00am</td>
</tr>
<tr>
<td>McGilvery</td>
<td>Service Sat. &amp; Sun. 7:00am –</td>
</tr>
<tr>
<td>Classroom</td>
<td>Happy Hour 11:00pm</td>
</tr>
<tr>
<td>58</td>
<td>M-F 4:00pm-7:00pm</td>
</tr>
<tr>
<td>U-Shape</td>
<td></td>
</tr>
<tr>
<td>38</td>
<td></td>
</tr>
<tr>
<td>Banquet</td>
<td></td>
</tr>
<tr>
<td>120</td>
<td></td>
</tr>
</tbody>
</table>
PEOPLE TO KNOW

President Warren
President

Valoree Vargo
Chief of Staff

Joel Nielson
Athletic Director

Steve Sokany
VP Institutional Advancement

Lawrence Carter
Foundation Asset Manager KSU Hotel

Jen Arnold
Director of Advancement Events

Danielle Cordes
Assistant Dir. of Advancement Events

Jeffery L. McLain
Foundation Board Officer

Gary L. Brahler
Foundation Board Officer

Larry R. Armstrong
Foundation Board Officer

Michael Strebler
Foundation Board Officer

F. Carl Walter
Foundation Board Officer
KSUHCC JOB DISCRIPITION OVERVIEW

Front Desk Agent

Front Desk Agents are responsible for greeting and registering the guest, providing outstanding guest service during their stay, and settling the guest’s account upon completion of their stay. Primary responsibilities include: registering guests, making and modifying reservations, hotel operator, and concierge duties. They must possess a positive and upbeat personality with a desire to deliver outstanding customer service to our guests. They must have the ability to multi-task, be detail-oriented, and be able to problem solve in order to effectively deal with internal and external customers.

Night Audit

Night Auditors are responsible for the front desk operation during the overnight shift. Primary responsibilities include: registering guests, making reservations, preparing daily reports, balancing transactions, and conducting security walks. They must be able to problem solve and troubleshoot in order to resolve guest issues that may arise and respond to emergency situations.

Concierge

The concierge is available to answer any guest inquiries regarding the city, events, and attractions. This individual will provide exceptional customer service to all of our guests and will support other departments including Sales, Front Office, and Bellman/Van, as needed.

Security
The Security position will encompass aspects of both the Night Audit and Front Desk positions as well as overseeing the safety and security of the hotel and guests throughout the evening hours. Additional responsibilities include: conducting security walks throughout the hotel property and responding to guest requests and any noise complaints. Security agents must be able to problem solve and troubleshoot in order to resolve guest issues and respond appropriately to emergency situations.

**Executive Housekeeper**

The Executive Housekeeper is responsible for all duties of the housekeeping operation and cleanliness levels in all areas of the property. Responsibilities include: staff training, inter-department communications, and staff scheduling. The Executive Housekeeper will promote an atmosphere that insures the company mission statement, “Friendliness and Cleanliness”. This position requires strong attention to detail, leadership skills, and the ability to effectively deal with department heads, guests, and team members.

**Assistant Housekeeper**

The Assistant Executive Housekeeper supports the Executive Housekeeper in all duties of the housekeeping operation and cleanliness levels in all areas of the property. Responsibilities include: staff training, inter-department communications, and staff scheduling. The Assistant Executive will promote an atmosphere that insures the company mission statement, “Friendliness and Cleanliness”. This position requires strong attention to detail, leadership skills, and the ability to effectively deal with department heads, guests, and team members.
**Inspector**

Housekeeping inspectors ensure that the company meets all cleanliness and condition requirements. Responsibilities include recording inspection results, resolving guest complaints and maintaining accommodations standards. Their role also involves developing and training other housekeeping staff. Additional duties may vary by employer, but oftentimes, housekeeping inspectors take part in purchasing supplies and controlling inventory.

**Public Space**

The Public Space manager will supervise, train and inspect the performance of assigned Public Space Cleaners ensuring that all procedures are completed to the hotel's standards. Assist where necessary to ensure optimum service to guests.

**Laundry**

The Laundry Manager is responsible for ensuring that all laundry services within the property meet the highest possible standards. He/she organizes and controls the laundry department and maintains all relevant records. They are responsible for the proper handling of guest and house laundry and establishes standards and procedures to ascertain quality of work performed. The Laundry Manager also has to check the production methods and procedures and issues necessary orders to correct shortcomings and takes inventory supplies.

**Maintenance**

The Maintenance Engineer is responsible for maintaining the overall operation of the maintenance department and the appearance and working order of the hotel. The
engineer must be able to work independently, as well as, with others. Responsibilities may include: maintaining the exterior of the building, parking lot, and common areas, driving shuttle van as needed, maintaining all equipment in guest rooms, conducting monthly safety inspections and training the staff on safety and emergency procedures, and working with vendors. They must be willing to respond to emergencies, even if after hours, and work with corporate maintenance on special remodeling projects or capital expenditure needs. This position requires overall maintenance knowledge and trouble shooting ability with skills in painting, HVAC, carpentry, equipment, and tool usage.
FRONT DESK RESERVATIONS

Check-in Process

Each guest should be greeted with a smile. Remember the 10 & 5 rule

(10 feet acknowledge and 5 feet interact.)

1. “Thank you for calling the Kent State Hotel”

2. “How may I assist you today?”

3. “What is the last name for the reservation?”

4. “May I have your ID and form of payment?”

5. “What brings you to the area?”

   - Double-check address on ID matches address for reservation
   - Phone number
   - Confirm number of days staying

7. Ask guest if they need parking (insert accordingly). If yes, hand guest parking registration card.
   - They will need to fill out the card, providing Name, Car make and model.

8. Print sign-in sheet and hand to guest to initial and sign.

9. Ask guest the number of keys they need and make the keys requested

10. Continue to check-in and hand back ID & form of payment

11. Hand key packet to the guest. Show the room number and explain hotel amenities.
   - Pool is open 6am-11pm
   - Fitness Center is 24 hours
- Complimentary wireless (give log-in info)
- Continental Breakfast as well as a hot Breakfast
- Nineteen10 Restaurant and Lounge
- Let guest know if there is anything happening in the hotel (happy hour, pool is closed, events in the area… etc… etc.)

12. Hand #2 ticket and explain parking

- The PARTA Parking deck is located outside the front doors to the right.
  Drive North on South Depeyster and enter the parking deck. Take a ticket.
  Your parking ticket will be validated at the Front Desk prior to leaving the parking deck.

13. Direct them to the elevator

14. My name is “________”, Please let us know if you need anything during your stay

- Cash Paying Guest – refer to checklist
- Any guests checking in after 6pm should be asked if they would like a wakeup call.
- Offer to have someone call about room service. We can also see if they would like room service for breakfast.

**Magic Formula**

1. Answer within three rings.
2. Use approved greeting.
3. Make appropriate transfer.
4. Say reservations greeting.
5. Match day with date and determine number of people.

6. Ask about frequent stay program.

7. May I ask what brings you to the area?

8. Have you stayed with us before?

9. Ask for and use guest’s name.

10. Offer four personalized benefits before rate.

11. Upsell (two room options/rates)

12. Ask to confirm. STOP

13. Use resistance question.

14. Provide fallback options.
   a. Stress limited availability
   b. Give 2-3 additional benefits
   c. Mention guaranteed satisfaction
   d. Yield: Offer fallback rate

15. Try a second ask to confirm.

16. Thank you!

**Making a Reservations**

1. Either double click a cell in the available room screen or click reserve button and add reservation.

2. The check in date will automatically select the current date unless you are selecting a room and date in the availability screen. Double check the check in date, number of days staying, and out date.
3. Select the number of rooms the guest will need. If they need different room types, you will need to make separate reservation.

4. Select the number of adults and children in the room.

5. Use the drop down to pick the room type and CHECK AVAILABILITY.
   a. A green check mark will appear if that room type is available. If it is not, a Red X will appear.

6. Use the magnify to display Rate Codes and select the rate you wish to use.
   Typically, the rate will produce itself.

7. If the guest is eligible for a discount you will need to use the magnify to select the discount you want to use. You will also need to determine if this discount is for all days of their reservation or for specific days. If you choose to lock the discount any future discounts requested will be overridden by the original discount.

8. If the guest is tax exempt determine if they are state tax only or all tax exempt.
   a. Room Taxable means all taxes will be exempt.
   b. Room State-Exempt means state tax exempt.
   c. Room Full Exempt means no taxes will be charged.

9. If the guest is part of a group, you will type in the group code. Use the magnify to locate the correct group code. Highlight the group and click select and the reservation will be attached to the group. When making a reservation for a group, it is best to put the group code in first and the reservation will default to the group settings.
10. Enter guest information and go to the Other Information tab.

11. Select the hold type/how guest will guarantee reservation. Type in credit card number and expiration date. Confirm the name on the credit card because it will automatically default to the name on the reservation.

12. Users defined as managers and supervisors will be able to view credit card once it is saved by clicking icon next the credit card number.

13. Enter the name of the person making the reservation. This will help if there are any questions about the reservation.

14. Collect guests email so we can send them a confirmation number. The letter sent field will produce a date when we email, fax, or print a confirmation number.

15. Select market source and source of business.

16. Add notes in the Notes tab. Always add a Date Stamp before typing your notes so we know who took the reservation and when the information was taken in case a future note overrides it. Housekeeping notes are good for the request like no air fresheners or extra pillows.

**Check-out Process**

Each guest should be greeted with a smile. Remember the 10 & 5 rule (10 feet acknowledge and 5 feet interact.)

1. “Good Morning, how was your stay?”

2. “What is the last name of the reservation and room number?”
3. “How was everything with your stay? Was there on thing we could have done to make your stay more enjoyable?” Thank the guest for any feedback good or bad. “Thank you for bringing that to my attention.”

4. Would you like to use (form of payment) on file?

5. Would you like a copy of your receipt?

   **Reminder** no reservations from any third party or Direct Bill will receive a receipt for Master folio

6. “May I check any future dates for you?”

7. “Thank you again for being our guest and I hope you come back to visit soon.”
   - We want to make a good final impression. If there has been an issue alert a manager to fix it and we always should.
   - We can offer to purchase their breakfast, take money off their room, or even comp the room if need be. We always want the guest to leave happy so they come back and recommend us.
   - If a guest asks about comment cards, let them know we are on Trip Advisor and would love for them to leave a comment.

**Late Check-out**

- Latest Checkout is 1pm.
- Requests will be considered
- The latest check-out is 2p.m. Past 3p.m., ½ day stay rate will be applied.
o Total Stay → Rate details → Rate amount should be half of what is on
screen → Close → Insert → 100% room taxable in amount →
voucher: ½ stay → OK

Concierge Service: Wow Factors

• Provide Recovery Bag to the guest
  o Bottle of water, popcorn and 1 additional item
• Purchase New York Times from local store if someone requests for it
• Take their laundry to Flashes drycleaners

Service failures that the Kent State Hotel experience:

If the guest(s) room is currently not available…

• Front desk agents have permission to adjustment the room rate price. The
  lowest bottom rate is $109.00
• Offer the guest a complimentary cocktail or appetizer at the restaurant

Online reservation failures…

• After receiving information about the online reservation complication, the
  front desk agent will investigate why it happened.
• Expedia tends to allow overbooking and/or allows booking of a suite when it
  is not available.
• The Front desk agent is permitted to provide a complimentary dinner the at
  the restaurant.
Denials

The Reservation Denials feature allows you to track the reasons a customer balks at completing a reservation transaction with your property. This denial is really Lost Revenue.

If a person attempts to book a reservation and then declines, the user can select Front Desk > Reservation Denial, Ctrl+Alt+L or the Denial option on the secondary toolbar and quickly enter a reason for the refusal. Refusal reasons can be preset (such as "Rate too High", "No Pool", "Just Checking Rates", etc.) by selecting the Setup button in the Reservation Denials browse screen. You can also run reports to total the reasons at any time to evaluate why guests decline to book a reservation at your hotel.

Adding a Reservation Denial

Go to Front Desk > Reservation Denials/Lost Revenue > Insert or press the Denial button on the secondary roomMaster toolbar.

The Reason drop down selection box allows you to pick a denial reason from a list of predefined reasons. You can pick the reason that best matches the customer’s explanation for cancelling their reservation or not continuing through to a completed reservation.

Comment

The Comment text field allows you to enter in any additional comments that you want to record or bring to management's attention. The comment text entered here will appear on the Reservation Denial Report.
Check-In

The Check-in Date selection spin box allows you to quickly select the date of the reservation that is being cancelled or the anticipated reservation date provided by the customer when they made contact with your property.

Reservation Cancellations and Denials

Always prompt user when cancelling future reservations. Check this option to display the denial screen when a reservation for a date other than the current audit date is cancelled. The denial is automatically included with Reservations Denials. Always prompt user when cancelling current day's reservations. Check this option to display the denial screen when a reservation for the current audit date is cancelled or billed as a No Show. The denial is automatically included with Reservations Denials.

Restaurant Reservations

Important Notes:

For any given evening, we will be offering up to a 16 person’s reservations for a two-hour time slot in the restaurant for lunch and dinner. This is about 30% of our restaurant seating. These reservations do not have to be all one party, and will vary based on availability.

All reservations are guaranteed for a two-hour time slot. Make sure to note this to the guest when taking the reservation.

- For example, if a guest makes dinner reservations for 7:00pm, they are guaranteed that table from 7:00pm to 9:00pm.
When reserving seating for a party of 2, it is important to ask the guest if high-table seating is acceptable for their party. If a table of 2 comes in and is unable to sit at the high chairs (be it for accessibility reason or personal preference) we are not caught off guard without a low table seating for them.

Taking a Reservation Call:

- Answer the phone with the typical greeting.

- When guest expresses desire for reservations, it is important to be thorough in getting the necessary details from them. Typically, the best ways to do so is write down the information.

- Open the Nineteen10 reservations screen on the computer to their desired date to make sure we have availability for the day and time requested. Due to our small size we can take on no more than 16 guests for a given time frame. If there is already a 7:00pm dinner reservation for a party of 8, and a party of 4, you cannot accommodate a party of 7 in that time frame. See below for what to do/say in the event that we are booked for reservations.

- If we have availability, get information from the caller. You will need their name, phone number, number of guests in their party, desired date and time of arrival. Make sure to also ask if their visit marks a special occasion and make note of it. Make sure to repeat all details back to them to assure correctness. Remind the guest that all reservations are for a two-hour time slot.

In the event that we have too many reservations for a given time frame and cannot take on a guest request for reservation, it is important never to tell them that "we are full", 
as that is simply not true. As a first alternative, you can suggest to them a different timeslot where you do have availability.

- For example, if we are booked for 7:30, suggest to the guest that while we do not have that time available, however we can accommodate you at 5:00 or 5:30pm for reservations.

If all other options are not what the guest wants, always offer to schedule a reservation for another day. Before hanging up, reconfirm the date and time with the guest, thank them for calling, and let them know you look forward to having them stay with us.

**Guest Requests**

Each day the Front Desk will take out a Guest Request Sheet and place it on the clipboard at the desk. Throughout the day as guests make requests we will to fill out the form:

- Date/Time
- Room # of request
- The request (detail request is necessary)
- GSR's initials (or whoever took the request)
- Done by (who are we reporting the request to so it is completed in a timely manner?)
- GSR's needs to let whoever is completing the request to know that we need them to follow up that it is complete so the GSR can follow up with the guest that they are satisfied.
Once the request is completed and the GSR makes sure the guest is satisfied they and mark the time completed and initial. (This is important if the request is followed up on by a different GSR then who took the request.)

Examples:

- Extra towels
- Another coffee
- Extra pillows
- Wake up call

This report is to be used by each shift and the night audit is to place it in Megan's mailbox for review. If a request has not been taken care of I need to know why and when it will be complete.
HOTEL BILLING AND PAYMENTS

Cash Deposits

At check in we need to request to see a credit card and an ID from a guest. There will be some cases where a guest does not have a credit card and simply wants to pay cash for his/her room.

We are able to take a cash deposit in place of a credit card but we have to use our best judgment when we do so.

- A cash paying guest must pay the cash total up front plus a cash deposit of $25
- Depending on the length of stay we should request $50 per day. The deposit is a security deposit only and cannot be used to charge incidentals. See the MOD if you are unsure.
- The guest should be informed that at check out the deposit will be refunded to them however, they must present their ID (the name on the room) and housekeeping will need to inspect the room before the cash is refunded.
- Place the deposit in an envelope with the guest name, check in and check out date, amount of deposit, and your name. Keep at FD, left drawer.
- At check out once housekeeping gives us the ok get the deposit out. Have the guest sign the receipt book showing they received the money back.

When a guest pays cash and leaves a cash deposit you should make sure you note it in the log book and reservation so that the Managers and other Front Desk Agents are aware.

Debit Cards
When dealing with debit cards we all need to be on the same page and use the same terminology. Here are some key points to remember:

- You need to make sure the guest is looking and listening to what you are saying.
- It is important that they understand we can only run it as a debit and that the BANK is holding their funds based on our authorization.
- Be sure they do not plan to pay cash at check out. If they do you can recommend they pay the total room and tax and then just authorize their debit card for $30.
- You can recommend that they use an actual credit card to check in and then check out on their debit card.

This is what you need to say when you see you’re taking a debit card:

“We authorize all credit and debit cards for room and tax plus 15%. Once you depart the hotel we will charge your account for the total and release any additional authorization you have not used. Because this is a debit card your bank may hold the authorization like a charge to your banking account and they may hold the authorization for 10-15 business days after you check out.”

**Petty Cash**

Petty cash is a small amount of cash on hand that is used for paying small amounts owed, rather than writing a check. Some examples for using petty cash include the following:

- Paying the postal carrier the 17 cents due on a letter being delivered, reimbursing an employee $9 for supplies purchased, or paying $14 for bakery goods delivered for a company's early morning meeting.
Every time we pay the petty cash, we need to ask for the receipts, and fill the petty cash form in the draw #1. For each shift we will have cash income. If the cash income is more than the petty cash we should drop the petty cash receipt and the rest of the cash income. If the cash income is less than the petty cash in your drop, you should just drop your cash income and leave the receipt in the draw.

Example 1. Your cash income is $25. And the petty cash is $10. We should drop the petty cash receipt, and also $15 cash. That way the drawer will balance as $200.

Example 2. Your cash income is $5. The petty cash in $10. We should leave the petty cash receipt in the draw, and just drop the $5 cash. When we count the drawer, include the petty cash, the draw should still balance as $200.

Adjustments

Adjustments are to be done by a Supervisor or Manager and should be kept to a minimal. When an adjustment is made in the PMS, be sure that a Refund/Paid out slip is filled out completely with explanation.

When an adjustment is made and it creates a credit balance a paid out is to be done. Fill out the same form and be sure the guest signs the paid out prior to giving out any cash. These forms are to be put into a binder that should be kept in date order by month. When making adjustments to revenue it is best to adjust the difference,

If you adjust the entire amount, then repost the correct amount - the system will see that as a room being sold and will cause an issue with the total rooms sold at the hotel for the day. So if the original room rate charged was 150.00 and it should have been
100.00 you will adjust the 50.00 plus the taxes. Be sure an adjustment slip is done for every adjustment.

Print a copy of the folio and put in the front desk mail box. This would be the same with the banquet revenue. Just adjust what the difference is not the entire amount. If you need to make an adjustment on a banquet check that an adjustment slip still needs to be completed.

**Trade-out Procedures**

There is a common arrangement in the hotel business where the hotel receives goods and/or services in exchange for rooms, food, and/or beverages. Overwhelmingly, trade-out is used to purchase advertising. The following points must be kept in mind and adhered to:

- The hotel is still the buyer and the advertising source is still the vendor. The only difference is the method of payment for the advertising. Instead of money, you are paying with goods and services.

- All trade outs must be approved by the Director of Operations prior to entering into a contract with any company.

- The contract must include the provision that the vendor is not to receive any portion of the rooms, food, and/or beverage until that amount of advertising has already been received. This is not barter; the hotel has purchased advertising and should not pay for anything it has not received.
• If you are trading other hotels or restaurants for certificates for employee welfare, sales give-a-ways or guest relations get the equal amount from them, dollar to dollar.

• There must be an expiration date for the validity of the trade-out (usually six to nine months but no longer than 1 year).

• The contract must exclude certain dates from availability, both for rooms, food, and/or beverage. Clearly, blackout all possible or close to sellout dates for rooms. Also, exclude high traffic holidays from food and beverages such as Mother’s Day, Valentine’s Day, etc.)

• The contract must specify the exact dollar value of each room, food and beverage. They will receive, each good and service itemized. In addition, it is important that you get dollar for dollar in exchange.

The following are the set-up and accounting procedures for this non-cash transaction:

1. The General Manager if there is not an Accounting department, must determine the actual cost of what the hotel is exchanging for the advertising and or certificates.

2. Because we have received the advertising, we have incurred a liability. The vendor is now free to consume rooms, food, and/or beverages according to the terms of the contract. However, this liability does not belong to Accounts Payable because it is not a cash liability and because it is essential to keep all trade-out balances separate. They are to be monitored separately from other payables.
3. When the GM or Accounting receives an “invoice” for the advertising (which has already run), the invoice should be marked “Trade-Out” and kept in a file created for trade outs with the contracts.

4. On the Trade-Out spreadsheet you will track the company the trade is with, along with the total of all invoices involved. You will record all services that the hotel provides by dollar amount. The spreadsheet has a declining balance so you will be able to see where you are with the trade.

5. When the vendor has consumed the rooms, food, and/or beverage, the vendor should sign for the services on the folio/registration card or guest check and it should be treated as other receivables. A copy of these signed documents are to be kept with the contract as backup.

6. A room trade will not post room and tax but the rack rate for the night will be recorded on the spreadsheet. Make a copy of the guest registration card for the file.

7. The restaurant charges you will need to create a “house account” in the PMS for the trade-outs and or gift certificates redemption. When a trade-out is redeemed in the restaurant a guest check will be created and only the amount of the gift certificate will be applied to the guest check and closed out for the amount.

8. At the end of the month, the house account will be written off and coded the appropriate account number in the Advertising & Promo department.

9. The total amount of the charges should be recorded on the spreadsheet and copied for the file.
PARTA PARKING

Adding PARTA parking charge using the Daily Charge function.

This will automatically post the parking to the guest folio when room and tax is posted to the guest folio during audit.

- For either an open reservation or folio, go to More Options > Daily Charges and Packages.
- Click Insert
- In Type, enter the account code which for PARTA Parking is 125
- It should automatically produce a Flat Rate of $10
- Check sub folio, make sure you put that into the right Sub folio. For **EXP guest**, the parking charge should be in folio B which is incidentals folio.
- You won’t need to change the days of the week because the charge is always the same
- Click OK and the charge appears as a line item in the Current Daily Charge and Package Options section of the window.

When the audit is run, the charge will automatically insert with the guests’ room charge. If you insert parking in the guest folio directly, and the guest also has the daily charge, it will double charge.

**Insert of Parking Charge**

1. Open the guest's folio, click "more options"
2. Find "Daily Charge and Packages", click it.
3. Click "Insert"
4. Type in code "125", hit Tab button, it will automatically fill the price $10

5. Check Sub folio, make sure you put that into the right Sub Folio. For EXP guest, the parking charge should be in folio B which is incidental folio.

6. Click " OK"

7. Exit the guest folio.

When audit is run, the charge will automatically insert with the guests' room charge.

If you insert parking in the guest folio directly, and the guest also have the daily charge, it will cost double charge.
GIFT CARDS

When a guest is requesting to purchase a gift card for the restaurant or hotel you first need to determine how much they want the certificate to be worth. Once you know that you need to locate a Manager to have one created. (If a Manager is not presented get all their information and let them know someone will contact them soon).

- Once a gift card is made, a copy needs to be made and marked copy and placed in FOM's mailbox.
- Go to desk folios and find Gift Cards.
- Insert a gift card load (351) for whatever the amount is that the gift card is for.
- In the voucher area type the card number.
- Insert a payment of the method of payment they are using (we do not accept personal checks).
- Print a receipt for the guest and for your records. (Needs to be balanced with your shift report).

When we receive a Gift Card at the front desk we need to go to the gift card binder and verify if the card has been redeemed yet or not.

- Get CC at check in for incidentals and retrieve certificate from the guest
- The certificate must be presented to us for the comp rate. If the guest does not have it with them you must change the rate to RACK.
- Once you have checked the guest in check the gift card binder to see if the card has been redeemed yet or not. If it has been redeemed notify a manager
immediately and they will take appropriate action.

- If it valid, initial on the gift card log that you took it in, write the guests name and arrival date on the gift card, put in my mailbox.
- You will now have to insert gift card (350) onto their folio to account for the amount.

**How to Sell a Gift Card:**

Go to Desk Folio > Gift Card Sales > Enter the payment.

1. Press INSERT.
2. Enter the code for payment type. 200 = Cash, 202 = Visa/MC etc. Enter the amount.
3. Press OK to confirm (credit card will process)

Now issue the Gift Card...

1. Press INSERT.
2. Enter code 351 - Gift Card Load
3. Enter the amount.
4. Press OK.
5. Swipe the Gift Card to activate.

To complete the transaction, press CHECK-OUT. Print two copies of the folio.

Folio will re-check in for next sale.

**How to Redeem a Gift Card:**

1. Press INSERT.
2. Enter code 350 - Gift Card
3. Enter the amount.

4. Press OK.

5. Swipe the Gift Card

**How to Determine Balance on a Gift Card:**

Back Office tab > InnQuest Gift Card Maintenance > Card Inquiry tab, press SCAN CARD. Current balance will display on bottom

**Paper Gift Certificates**

Paper Gift Certificates were issued prior to opening of Hotel by management. They were given as complimentary Room/Tax (such as donation) AND some have cash value which will state on very top of Certificate. They are ONLY for King or QQ room types.

Below are instructions on redeeming them. NOTE: We only accept complimentary Gift Certificates when the RACK rate is $129 or less. Please check availability screen for RACK rate. All Gift Certificates state based upon availability and blackout dates (New Year’s Eve, graduation, etc.).

1. **Booking a Complimentary Reservation:** Ask the caller what type of Certificate they have (complimentary or amount on top).

2. If COMPLIMENTARY AND RATE IS BELOW $129- book reservation and RATE CODE is COMP. In the notes section state the GC#.

3. Check guest in as normal. Ask for Credit Card information for incidentals.

4. Check-out as normal.

Booking a Gift Certificate that has Cash Value Amount on Top:
1. Book reservation - RACK RATE ONLY

2. Upon C/I retrieve GC from guest, staple to sign in sheet - MUST be original GC, not copy

3. Get CC, proceed as normal

4. Insert code 353 - Gift Certificate Redemption

5. Add amount of GC

6. Add GC # in voucher line

It will show a negative amount until audit runs. If there is a balance upon C/O, they will pay it.

Example: Total Room/Tax = $120.27 > GC is worth = $100.00 > upon C/O they owe = $20.27
FRONT DESK SAFETY AND SECURITY

**Guest Rooms**

Never announce a guest room number. Write it down and point it out. If a guest can’t see it then you can privately verbalize the room number. If someone calls to speak with a guest whether it is an in-house or outside call, you must ask the caller to verify the person they are calling.

- “Can you verify the name on the room?”
- If they can’t then you can’t transfer the call.

Always see a proper ID when giving out guest room keys. If the name is not listed on the room than you may not provide the room number or key. It does not matter if they know who is in the room or the room number.

- You can call the guest staying in the room to get permission to allow the guest access.
- Be aware of who should and should not be in the hotel.

**White Panic Button**

We are always trying to make our hotel safer for our employees and guests. In this attempt we have installed white panic buttons under each computer. If the FD is ever to be an incident, please follow these steps:

- Stay calm and push white panic button - your safety is most important.
- Give whatever is asked in the incident. We have our reports to refer back on.
- They will be on camera but look for anything unusual-tattoos, scar, etc.
What will happen after the button is pushed:

- Automatically goes to alarm company and Kent Police.
- Kent Police will be there is less than 2 minutes and hotel secured.
- Management (Mike, Stephen and Tammy) will get a call immediately from the security company.
- Due to proximity of hotel. Stephen or Tammy will arrive at hotel.

**Night Audits**

For guests that are staying in the hotel they are to let themselves in with their room key.

“Guest: Please use your room key on the gray pad to the left to unlock the door.”

We know that only guests after 11pm are coming into the hotel.

“Guest: If you do not have your key, please use the phone to the left to call Front Desk. Give them your name and room number and have your Photo ID ready.”

When night audit or security goes to open the door we can confirm that it is a guest and we can make them another room key.

**Arrivals:** For our arrivals for the evening after 11pm.

“Arrivals: Please pick up the phone and confirm your name on the reservation. Have your Photo ID and form of payment ready?”

When night audit or security goes to open the door we can confirm that they are a guest checking into the hotel.

“Walk-in Arrivals: Please pick up the phone and speak with a front desk agent for availability. Please have Photo ID ready.”
Night audit can see if we have a room available and if we do, they can let them know the room type and amount. Meet them at the door with Photo ID.
FRONT DESK GUIDELINES

Department Organization

Bulletin Boards:

- Items should be hung up with no more than 2 pins at the top and bottom of the posting.
- No Ads without General Managers approval
- All postings should be neat. Typed is preferred.
- Keep it organized by removing irrelevant things weekly.

Desks/Workspace:

- Things should be organized in a manner that anyone would be able to navigate through if need be.
- All trash in trashcans
- Label your files
- Keep drawers and cabinets organized as well. Just because it is closed doesn’t mean it should be a mess.

Cash Drawers

In order to insure accuracy and accountability the following guidelines must be followed.

- Each team member must work out of their own cash drawer. No sharing or using other drawers for change.
- All need to count cash drawers for both start and end of shift.
• You must use your personal sign on and not work from a computer that someone else has signed on to.

• Individual shift reports will be done by all at shift’s end.

• Team members must sign off computers while on break and at shifts end.

Each morning a cash count slip will be placed in both cash drawers by the night auditor.

• Every shift, AM/PM, is to count the drawer they are working on at the beginning and the end of their shift. The leaving shift needs to wait to drop their money and leave until the oncoming shift has counted the drawer and can confirm what they say is there.

• Every shift, Night Audit, is to count both drawers at the beginning and the end of their shift to ensure they are both at $200. Before leaving shift to drop their money, they need to wait for the oncoming shift to count their drawer and confirm what they say is there.

• At the end of the shift, your drawer and any amount over needs to be dropped into the safe. When you print your shift report if you have taken in or have refunded cash you need to make sure the drawer is at $200 no matter what.
  o There is no reason your drop or drawer should be over or short from what the report says. If it is then you need to leave a detailed note with your drop explaining why and notify the manager on duty or send an email to Theresa.
  o Please place a copy of your shift report in your drop. You will use your shift report to label your drop envelope with your name, date, working
shift, drawer number and amount. Make sure someone else counts your drop and witnesses you dropping it in the safe, along with a witness to sign on the cash count form in the back office after your drop.

- If you have given a cash refund during your shift and have not taken in enough money to drop the petty cash slips, you will need to drop short so that the drawer stays at $200. Your shift report should reflect this by putting the amount that you are actually dropping on the line, next to the amount you are to initially drop.
  - Each shift after should make sure that if they have taken in enough cash to drop the petty cash slip, they drop the slip and NOT the actual cash.
  
  Keeping the drawer at $200 still.

Side note: If 2 people are working they are NOT to share a drawer. The second person MUST work on the other (open) drawer. It is VERY important that we get deposits right.

**Flashmart**

Determine whether they would like to pay cash or charge to their room. If they would like to charge it to their room:

- Go their room number in roomMaster
- Select insert
- Look for Flashmart taxable and post the amount for the items they are purchasing
  - You can create a second incidentals only folio if the guest prefers but this is not necessary all the time.

Flashmart purchases without a guest room:

- Go to desk folios in roomMaster
• Find the “Front Desk Sales” desk folio

• Select insert

• Look for Flashmart taxable and post the amount for the items they are purchasing

• Make sure you get the cash and post it against the folio

• Print a receipt for your records so when you balance your shift you know what your drop is
  
  o This folio is set to automatically check itself back in when checked out
  
  o Make sure you ask a guest before posting if they want a receipt and if they do check out the “Front Desk Sales” desk folio first.

Keeping the Flashmart stocked:

1. Every shift should check the Flashmart to be sure the shelves are stocked

2. Make sure all items are facing forward and look organized

3. Check the storage (TBD) to be sure nothing is running low

4. Let Andrea know if something is running low

5. If you have a special request from a guest of something they think people will like or you have an idea, please let Andrea know

Inventory:

1. Inventory will be done monthly

2. Every item in out or in storage needs counted and record

3. If a new item isn’t on the list, please write it down and count it
4. Once every item is counted enter it into the spreadsheet

5. Email to Theresa and Mike

Safe Deposit Box

We have 10 safe deposit boxes in the back office.

Bring the guest to the back office area and show them the safes. Allow them to open the safe and place the item in the safe. Tell them to keep the safe key with them, we have envelopes to keep them safe if they would like one. Fill out the information on the envelope with their name, room number and safety deposit box number.

Have the guest then fill out the security deposit card that is located at the front desk in the black clear, filing box. Have them fill out their name and anyone else that can have access to the safe box, address and room number on the front side. At the bottom, get their signature and make sure that you date the bottom and sign as the witness (clerk).

If the guest comes back to enter the safety deposit box, on the back of their card, where the lines are, have them sign or print their name under the guest column and yours goes in the clerk section. Make sure that you put the safety box number and date they are entering on their as well.

If the guest is coming back to get their items out of the box them make sure they just sign off on the back of the card, where the lines are, at the very bottom where it says, “I hereby acknowledge that all property placed in my safe deposit no. ______ has been removed. The key is hereby surrendered.”

Staff Areas and Use in the Hotel

Entrance
At 5am the night auditor will unlock the employee entrance so that the first kitchen/restaurant staff can enter that way. The employee entrance should get locked by 6pm every night. Any employees coming in for their shift between 6pm and 5am may have to use the front doors.

**Smoking Area**

- Outside the employee entrance there will be an ash urn for cigarette butts
- Any employees taking a smoke break should go out the employee entrance
- We do not want you all going out at once. 1-2 people at a time please
- Do not use milk crates for seats
- Please pick up your trash and put it in the trashcan
- If you are caught throwing your cigarette butt or any other trash on the ground disciplinary action will be taken

**Break Room**

- Dispose of your trash
- Make sure you leave the break area cleaner than you found it
- If you find a mess, please clean it up
- If necessary restock the bathroom with soap, toilet paper, paper towels…
- Do not hang anything on bulletin board without manager approval

**Work Space**

- Work spaces are to be kept neat and orderly
- Clutter should never be seen visible
• Use idle time to clean

**Uniforms**

Important Notes: It is important that uniforms are immaculate at all times and mandatory. While at work, Front Desk Agents are representing not only the Kent State University Hotel and Conference Center, but also Nineteen10 and the University.

Things to Maintain:

• Shirts: Blue button down shirts must be free from all stains and neatly pressed.

• Pants: Navy pants or slacks (provided) that must be free of stains and neatly pressed. Should be free of wear and properly hemmed.

• Vests: Must always been worn, free of stains, and pressed.

• Tie or Scarf: Always be worn and free of stains.

• Shoes: Dress shoes Black or Navy. No open toed shoes of any kind are permitted. Should should blend in with the rest of the uniform.

All Front Desk Agents should maintain an overall clean presented look and practice good hygiene. Jewelry should remain minimal.
**Front Office Log**

Each hotel managed by Riley Hotel Group must have and use a Front Office Log. The Log must be a bound (sewn, not loose leaf or spiral bound) ledger or diary with stamp or machine numbered consecutive pages.

The Front Office Log has several uses:

- Record unusual incidents and significant guest comments
- Note the witnessing of deposit drops
- Note discrepancies in House Bank and Petty Cash counts at shift changes
- Note problems or issues which occur during the shift which the General Manager or subsequent shifts should be aware of

Entries must include the date, time and GSA's initials.

Each GSA must read the log of the prior shifts to be brought up-to-date on recent events. It is essential that all GSAs make entries into this log during their shift and read it religiously.

The General Manager and/or the Front Office Manager must review the Front Office Log periodically (at least daily) and initial each entry they review.

**Maintenance Log**

Throughout the day as guests or staff make requests for something to be repaired we will go into roomMaster to the > Front Desk tab > and click on Maintenance Items (Ctrl +I). This will bring you to the main screen where you can then click on the bottom right side > Insert, to create a new request sheet. You will then follow the boxes picking the accurate drop down item or input the word yourself in the box. (There is a limited
amount of words for the first three boxes describing the location). Make sure you always “Date Stamp” before writing your detailed description as to what is wrong and needs attention. If this is an urgent item, make sure that you check that box. Once the task is completed, you will then hit “OK” and it should take you back to the main menu. If an item is in the system as urgent it will be in red writing, if it is broken but doesn’t have to be fixed in 24 hours, then you can refrain from using that button.

**Down Time To-Do List**

- Wipe off counters at front desk
- Organize drawers/cabinets
- Make copies
- Clean business center
- Refill printer paper at all front desk printers
- Go through future reservations and the waitlist
- Restock Flashmart (alert Andrea if low)
- Refill Wi-Fi slips, luggage tags and key packets
- Print off copies of papers needed in the clear black filing box/menu box
- Call around to other hotels in the area to see what their occupancy is
- Look up reviews for the hotel on third party sites (alert manager of any good/bad reviews)
- Check lobby area periodically for cleanliness
- Restock cabinets in back office for beverage supply (alert Andrea if low)
- Signature couching calls (fill out form)
• Training mode (Practice making reservations, checking in and out, posting charges)

• Role play scenarios with a co-worker (Use real life situations, write it down and what you discussed, put in Tammy’s mailbox)

Receiving Shipments

These instructions are being provided in order to minimize your hotel's losses due to both incorrectly packed shipments as it relates to quantity and damages en-route. Your cooperation in following these procedures is both expected and appreciated.

Shipments will arrive at your hotel by many delivery means. Among these are postal carriers, overnight couriers (FedEx), parcel services (UPS) and common freight carriers (truckin...
Whenever possible obtain a copy of the original order before opening any shipment. Compare the packing list, if available, to the order. Note discrepancies. After completing this, open and check packages to make sure what is on the packing list, and/or order, is what is in the shipment. In addition to counting, check for damage of any kind, keeping in mind that damage can be concealed. Note on the delivery receipt any crease, dent, tear, or watermark on the containers.

It is critical that with shipments received from a common freight carrier, such as linen or terry, furniture, televisions, ice machines, HVAC units or something similar that all the boxes be opened and counted prior to acceptance or signing any document. No matter how much the driver complains or how long it takes, you must do this. Don’t let them bully you.

Remember, each box must be opened, counted, and checked for damage prior to the signing of the driver's bill-of-lading. Verify model numbers and verify against the order. If anything is damaged or its condition is not acceptable for any reason, do not accept it. These items should be checked by the General Manager or the appropriate supervisor immediately. The common freight driver will tell you none of these things are his/her problem and that only a note should be made on the bill of lading he presented for signature. If you cannot get him/her to take back the damaged items prepare a list detailing all the problems, both of you sign, date and note the time and give the driver a photocopy.

Food product is shipped in its own case. Double check the cases of each item against the order to assure it is the right product. In order to assure the delivery is intact,
it must be opened and counted before the shipping notice is signed for the driver. Do not sign anything until you are completely satisfied that what you see on the list is what is in front of you in good condition and not damaged. If the food delivery driver offers a credit slip instead of taking the unacceptable product back, that is acceptable.

Again, in the case of a common freight carrier, the driver may insist that the bill-of-lading be signed before boxes are opened so he can leave, do not do this. As soon as you sign the bill-of-lading, if there is a problem, that problem becomes ours and the driver is long gone. The driver cannot leave until he has a signature, do not sign until you are completely satisfied with the order. According to federal laws, once you sign for the goods, you become responsible.

Nighttime Amenities

At all times the front desk should have a full stock of amenities (soap, shampoo, lotion, mouthwash, toilet paper, tissues, tea, sugar packets, honey, water/coffee cups, coffee decaf/regular, silverware etc...)? If we are running low make a list of what we need and how much and let housekeeping know by 3pm. They will make sure by the end of the day you are restocked.

Each night the Executive Housekeeper or the Housekeeping supervisor will provide the front desk with a cart of amenities. If we have a P.M. public space person working they will run things for us and when they go home for the night, they will provide these items instead.

1. 10 Bath Towels
2. 10 Washcloths
3. 10 Hand Towels
4. 2 Pillows
5. 2 Blankets
6. 1 King Sheet Set
7. 2 Queen Sheet Set
8. Extra toiletries (soap, shampoo, lotion…etc.)

If your stock gets low because it is busy you can request that someone from another department that is working to restock your cart for you or if it is close to shift change you can restock it before you leave.

When a guest requests an item it is important that we honor and accommodate the request the best we can. Unfortunately, that doesn’t always mean we can run to their room with whatever they need. Let the guest know, “yes we have the item if you would like to stop by the front desk.” When they stop down be sure to thank them for being our guest and ask them if they need anything else.

**Shift Close**

1. Cash Drawers should always be balanced at the beginning and end of your shift at $200.

2. To close your shift, go to Front Desk > Shift Reports > Shift/Review Close.
   a. Shift 1 – Day close to 7am, Shift 2 – 7-3, Shift 3 – 3-11, Shift 4 – 11 to Day end
   b. Drawer 1 – to left / Drawer 2 - to right
When closing your shift select the shift you’re working and the drawer you’re using (see above info on shifts and drawers).

**For User: You roomMaster Login.**

You should close your shift/regardless of monies being taken in and print the report whether it is blank or not.

When it asks you if you want to close your shift always say no. The oncoming shift will manually change to their shift once they confirm that the drawers are in balance.

To Change shift use control n and then select the correct shift.

A side note: The shifts should only be changed if during the above mentioned Shift periods. If you are a “cover”, just do your Shift Close to drop your cash, but do not change the shift.

**Medical Emergency Procedures**

When notified of a medical emergency:

1. **Obtain the following information:**
   
   a. The victim’s name
   b. The victim’s location
   c. The nature of the emergency
   d. A call back number

2. **Call 911 and give the following information:**
   
   a. The building’s name
   b. Address
   c. Nearest cross street
d. The nature of the emergency

e. The victim’s general condition and location

f. Your call back number

Important: Do not hang up until the operator does.

3. If appropriate, security personnel should secure the largest elevator in the lobby for use by the emergency personnel.

4. Someone should go to the victim’s floor to assist.

5. When emergency personnel arrive, they should be met outside the main entrance of the building. Give them all pertinent information and escort them to the victim’s location.

Do not release information of medical emergencies to anyone other than management and emergency personnel. Cooperate fully with emergency personnel. Do not offer any further help when they ask you to stay out of the way. In the event of a death, secure the area around the body until police arrive. Do not allow others in the area. Seek assistance from other employees if necessary.

Never refuse to call emergency personnel for anyone who requests it.

- Call emergency personnel even if the person requesting emergency attention does not seem like a responsible person, or he/she appears to be in good health or does not appear to need emergency assistance.

- Never stand in the way of anyone who seeks emergency assistance.

- Call emergency personnel even if fire or police personnel have responded to the hotel for a person, and made comments about that person being crazy and not in need of
emergency personnel, and the person later summons you to call emergency personnel again.

- Do not, under any circumstances, make the decision that someone does not need emergency assistance after they’ve requested it.

**Lost and Found**

When a found item is brought to the front desk we need to log it and put it into the front desk cabinet underneath computer #2 for 30 days.

- To log lost and found > Control L or Front Desk > Lost and Found
- Click Insert
- Fill in as much detail as possible

If a Guest is coming to claim an item or we are returning an item via FedEx or UPS:

- Control L or Front Desk > Lost and Found
- Select the item being returned to owner
- Put in the return date and your initials.
- Select the other tab and fill in the owner information. Note who picked up the item if it was picked up in the hotel.

Side Note: It is important to log every item even if you know the guest will be returning soon that way we can keep track of the fact that items are turned in and are returned to the rightful owner.

If an item is of greater value (Phone, laptop, tablet, etc...) please make sure a
manager is aware and if the item is not going to be immediately picked up or mailed out it should be kept lock inside General Manager's office. Once we know when the item will be returned to its owner we will bring it behind the desk in the lost and found drawer.

After 30 days - The FOM will weed out any items that can be sent to housekeeping for storage. The Executive Housekeeper will then store the items until they have been kept for 90 days and then they will discard them. The Executive Housekeeper will then go into each item being discarded and mark the date discarded and their initials.

**Service Corridor and Meeting Space**

Important Notes: The service corridor is a space that all divisions and departments of the Kent State Hotel and Conference Center share. There are a number of different items throughout it and things can constantly be shifted or moved around. It is important that we assist in keeping this space clean and free of any hazards, so that all who use it will be able to access the things that they need.

Things to maintain:

- **Coffee Station.** It is important that all items are stored properly and the items and counter remains clean at all times. Use a damp rag to wipe down the surfaces surrounding the coffee station.
- **Glass Rack.** Any glasses not in use should be stored in glass racks of the appropriate size, and should be covered before storing for long periods of time.
- **Room Service Station.** Should remain stocked with the correct items needed for room service as well as clean orderly.
- **Ice Station.** Scoop should be stored properly in its holster at all times.
• Floor Space. The floor should remain clean and free of debris. It is the responsibility of the staff to make sure that any trash or obstruction is picked up and disposed of.

As with all spaces of the hotel, all trash must be disposed of in the appropriate containers. It is all staff’s responsibility to keep the corridor clean, regardless of the work that may require.

Meeting Space

• Doors are to be kept closed at all times when meetings are not in progress and lights are to be turned off.
• Events are to be broken down, equipment cleaned and stored in the appropriate location and in a timely fashion.
• Food or soiled dishware are never to be left in rooms overnight
• Tables are never to be left in hallways even if used the next day unless for early breakfast
PROPERTY KEY CONTROL PROGRAM

Key Control Program

In order to maintain a high level of security in all areas of the hotel, management must have a solid key control program in place. There are fundamental components to a well-managed and implemented key control program. To determine if those fundamentals are established at your property, just answer these quick questions:

1. Are all hotel keys kept at the property?
2. Are key sign-in/out sheets used daily in all departments?
3. Are keys kept in a lockbox; and the lockbox is located in a back-of-house area?
4. Are storage room doors and closet doors kept locked?
5. Are keys labeled with a coding system, not the actual location they open?

If you answered “No” to any or all of the questions above then your hotel does not have a well-managed or implemented key control program. Listed below are steps to take in order to ensure that your hotel has the best key control system in place to keep your employees and guests safe. We have broken this down into three sections:

1. Implementing Property Key Control
2. Front Office Key Control
   a. Establishing Identity of Guests
   b. Guest Room Keys & Guest Security
3. Maintenance & Housekeeping Key Control.
Property Key Control

Follow these steps in order to organize and manage the entire properties key control system.

Step 1

Two emergency key boxes will be made available specifically for the Kent Fire Department. One is outside the building on Depeyster St. and the 2nd is inside the building behind the Front Desk. Included are master keys, and elevator keys clearly marked which are to be separated from general maintenance keys. These are for Fire Department use only.

Step 2

A locked key cabinet and emergency key box will need to be purchased, unless one already exists, for each hotel and placed in the first level back office area on the wall. Each department has its own color coded zone.

- Green – Engineering
- Blue – Housekeeping
- Yellow – Front Office
- Orange – F&B / Breakfast
- Red – Administrative & All Manager / Supervisor Keys

Step 3

All of the keys used for each department (zone) listed above need to be placed on the Key Location Identification Sheet. See Exhibit A as an example. You will need to
walk around the property and identify every area that each department needs access to in order to do their job.

Exhibit A

<table>
<thead>
<tr>
<th>Zone</th>
<th>Location</th>
<th>Type of Key</th>
<th>Key #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Maintenance Shop</td>
<td>Metal Key</td>
<td>#1</td>
</tr>
<tr>
<td>Green</td>
<td>Boiler Room</td>
<td>Metal Key</td>
<td>#2</td>
</tr>
<tr>
<td>Green</td>
<td>Pool Pump Room</td>
<td>Metal Key</td>
<td>#3</td>
</tr>
<tr>
<td>Green</td>
<td>5th Floor storage</td>
<td>Electronic Key</td>
<td>#4</td>
</tr>
<tr>
<td>Blue</td>
<td>Linen Closet</td>
<td>Metal Key</td>
<td>#1</td>
</tr>
<tr>
<td>Blue</td>
<td>Laundry Room</td>
<td>Electronic Key</td>
<td>#2</td>
</tr>
<tr>
<td>Blue</td>
<td>Laundry Chute</td>
<td>Metal Key</td>
<td>#3</td>
</tr>
<tr>
<td>Red</td>
<td>Maintenance Engineer File Cabinet</td>
<td>Metal Key</td>
<td>#1</td>
</tr>
<tr>
<td>Red</td>
<td>Housekeeping Office</td>
<td>Metal Key</td>
<td>#2</td>
</tr>
</tbody>
</table>

**Step 4**

Now that you have completed the Key/Location Identification Sheet you can recognize what keys are being used in each department and how many keys need to be placed on shift key rings.

**Step 5**

Every key that is listed on your key/ location identification sheet needs to be put on one key ring and labeled A shift, B shift, C Shift; or however many key rings you would need at one time during a day. As an Example housekeeping will probably need 12 key rings during A shift so the housekeeping key rings should be numbered 1-12 vs. Shift A, B or, C. When your employees sign in for the day they will go to the front office
at each hotel and sign out which ever shift they are working. They should be able to use that shift key ring to open everything they would need. When they are done working it will be signed back in.

**IMPORTANT: KEYS ARE NEVER TO LEAVE THE PROPERTY! THEY MUST BE SIGNED BACK IN EVERY SHIFT. THIS IS EVERY KEY WITHOUT EXCEPTION**

For example: Housekeeping will need to make 12-15 shift key rings for the room attendants to use each day. Each key ring would contain an electronic key, laundry chute key and linen closet key. These are the only keys that the room attendants need to do their job. Once they are finished working for the day the shift key rings will be signed back in at the front office of the appropriate hotel. All key rings need to be attached to a lanyard so the keys stay on the employee and are not lost. The employees are required to keep the lanyard around their neck while they are working. Keys should never be left on carts, in guest rooms or left out in the open. See Housekeeping & Maintenance Key Control further below in this PAP.

**Step 6**

All of the keys on the Shift key ring need to be color coded according to their zone. For instance, all of the keys on the housekeeping shift key rings need to have a blue plastic cap (for metal keys – see Exhibit B) or a blue circle sticker (applied on electronic keys). You never want to label keys with the location that they open. Using this color coded system will be easy for employees to recognize and no one else will understand your system. Refer to the color zones in Step 2.
Step 7

Each manager in the department will also need a key ring made with each key listed on the key/location identification sheet in their zone and, they will also need keys for other areas that line level employees do not have access to. These key rings are labeled red.

For example: The chief engineer at the hotel will have a key ring with every key listed on the key/location identification sheet listed in the green zone (see exhibit A above) plus a key to his/her filling cabinet and any other area that the maintenance employees should not have access to. All of the metal keys on this key ring will have red plastic covers; all of the electronic keys will have a red circle sticker applied to them.

Check Point

Now you should have following:

- List of all keys needed for each zone
- Shift key rings created and color coded by zone
- Manager key rings created by zone and color coded red

Step 8

Now that all of the employees have keys to work with and the keys are organized and color coded, we need to talk about backups and the key cabinet. In Step 1, we mentioned that there should be one locked key cabinet at each hotel behind the front office. If you opened the key cabinet, you would see each of the shift key rings color coded by zone. Now you need to create at least one back up for every key in each zone. The backup keys should be separated by the colored zones. For instance: when you open
the lock box you will see all of the individual backup keys for the green zone and then the
green zone shift key rings and so on with the other zones. Blue, yellow, orange, red. See
Exhibit C for a suggested key cabinet and color coded tags. The key cabinet will come
with white key tags that can be color coded with color circle stickers, however, we
suggest that you purchase the color key tags to keep things extremely easy to use, identify
and, organize. The inside panel of the key cabinet should be used for all zone backups
and they will be separated by colored zone. The hooks on the cabinet door should be
used for shift key rings again, arranged by colored zone.

**Step 9**

In Step 1, we mentioned that there should be one emergency key box located at each
hotel in the back office. See Exhibit D for a picture of this key box. Inside this key box
should contain a key ring with one set of emergency keys. These keys would be used for
extreme emergencies only. The box is designed so that the glass can be broken and the
keys obtained quickly vs. searching for a key or key ring in the key cabinet. The key ring
should contain at a minimum the following:

- Electronic Key Master – this key will override the deadbolt on guest rooms and
  should be programmed as the emergency master in your electronic key system
- Metal key master to all storage rooms and closets
- Elevator Key
- Main Fire Pump Room
- Fire Alarm Testing Systems
**Step 10**

A key sign-out sheet needs to be used daily for each property. All keys taken out of the box need to be signed out at the front office and signed back in at the end of the day. See the standard key sign out sheet. At the beginning of every MOD shift, the manager on duty must audit each key box and ensure that all keys are accounted for in the key cabinet with the exception of what has been signed out at the time of the audit. The MOD is responsible for all keys on their shift and must make sure they are all accounted for prior to departing. If an employee or manager has left without returning their keys, the MOD should call that employee and have them immediately return the keys back to the property.

**Step 11**

This step is about organizing your electronic key masters. Each hotel has a programming which is used to create electronic key masters. These units are able to label in detail each and every electronic key master. It is important that you label the Master Keys that are created because if a guest room lock ever has to be audited we will be able to identify who was in the room when by what key was used. Most electronic key systems will allow you to write out a full name, if not then create a coding system of some kind. There should only be two people allowed to program master keys at the property and one of those people should be the chief engineer. Everyone that uses the key machine (front office employees, management, and engineering) should have their own individual codes to access the machine and perform functions. This will eliminate a
lot of confusion if a lock ever has to be audited. There should be master keys for these positions / uses:

- General Manager
- Manager On Duty
- Executive Housekeeper
- 2 to 3 Housekeeping Supervisor or Room Inspector
- 10-15 Section Masters – these would be programmed for specific guest room access and are the keys room attendants would use
- Chief Engineer
- 5 – Gen Maint
- Front Office Master
- Sales Master

Front Office Key Control

Establishing Identity of Guests

The front desk staff is responsible for determining that the hotel has full documentation as to the identity of the person checking in and staying at the hotel. It is the hotel’s legal responsibility to know who is in the hotel to the extent possible. This is done in two ways, depending upon whether the person is paying cash, paying through direct bill, or paying with a credit card.

If the guest is paying cash or paying through direct bill, the GSA must ask for a picture ID, most preferably a driver’s license. The following three comparisons must be made:
1. The name on the driver’s license as compared with the registration,
2. The photo on the driver’s license as compared with the person checking in
3. The signature on the driver’s license as compared with the signature on the registration. The driver’s license number should be recorded on the registration in the PMS.

If the guest is paying with a credit card, the following two comparisons must be made:
1. The name on the credit card with the name on the registration
2. The signature on the credit card with the signature on the registration.

A photo ID is not required and, in fact, is not allowed as per our agreements with the credit card companies. One point about credit cards and identification must be stressed: Just taking the credit card and pre-authorizing it is not enough, that is done to establish credit but it does not establish identity. The GSA must look and compare critical information on the card as well as use it to authorize charges.

If the name on the credit card is not the name on the registration, that is OK, but the credit card holder should also sign the registration. In addition, if the hotel has express check-out authorization on its registration form, it must be the credit card holder who must sign this authorization. If not, you will never win the chargeback if they were to dispute the charges.

**Guest Room Keys & Guest Security**

Control of guestroom keys is one of the cornerstones of what hotels should do in order to provide the safety our guests have a right to expect. We, as innkeepers, have an
obligation to take reasonable care that our guests will be safe in their rooms from intrusions by people who may have room keys.

The following list of policies forms the basis of a good key and lock control system:

- Room keys should not have any form of key tag which identifies the hotel or is unique to the hotel among the surrounding area's hotels. No key tag at all would probably be best.
- Room keys should not have the room number on them. Metal keys (as opposed to key cards) should be engraved with a four-character numeric code. That code cannot, in any way, directly correspond to the building or room numbers.
- When keys are given to guests at registration the guest's name and room number should not be said aloud if there are others in hearing range. Room numbers should be shown to the guest in writing with a reminder that they should note it if a guest check-in packet is not used. Explain to the guest that the coding system is for their protection.
- Guests should be asked for their room keys at checkout by the Guest Service Agents (GSAs). Hotel employees, particularly Housekeeping and Bell Staff or even Maintenance, who see guests who are obviously in the process of leaving the hotel for the final time (taking their luggage out), should ask guests courteously if they have returned their room key. This is also a good time to thank them for staying and other pleasantries, such as inviting them to return.
- Room attendants and others who find keys in guest rooms or elsewhere should place them in their pockets, not on their carts where they are accessible to others, and subsequently give them to their supervisor to be returned to the front desk.

- All section masters, room masters, grand masters and emergency masters, (normally kept in a safety box) should be signed out each time they are taken and their return noted. All of the above keys should be stamped "DO NOT DUPLICATE" if they are metal keys. Persons who carry these keys permanently should be spot checked to ensure they have them on their person and that the inspection is logged in the front office log.

- In any case of a lost metal key, the maintenance staff should exchange room locks around within a housekeeping section in order to save the expense of re-keying the lock or to re-key the lock if it has been moved numerous times. A log should be kept of all lock swaps and re-keying.

- If they are using metal keys, Maintenance should keep a record of how many keys it makes for each room and when they are made. This record should be reviewed on at least a weekly basis by the General Manager. The General Manager should initial and date the key making record each time s/he reviews it.

- Numbers on metal keys should be adjusted accordingly and over stamped or ground until the old number is illegible and the new number stamped nearby if locks are swapped in a section. As a standard practice, it is recommended that all locks in a section be moved at least quarterly.
• If a section master is lost under circumstances which may result in guests being at risk the section should be re-keyed. If a section must be re-keyed, consider also re-keying to a new grandmaster and emergency master so that you are in effect beginning a phased re-keying of the entire hotel.

• If a master key or emergency key is lost under any circumstances it should be reported to the Support Office immediately by the General Manager. After the circumstances are discussed, a decision should be made as to whether the hotel should be re-keyed.

• As an additional step, the General Manager, or somebody s/he delegates the responsibility to, should cross index all incidents of theft, missing property, damage, etc. as follows:
  - Room Number or Location. (Watch out for locks that have been moved).
  - Names of potentially implicated employees (usually more than one). You may discover that room thefts never occur when so and so is off or regardless of the room number so and so was on as Maintenance or Room Attendant.

• Remember, whenever key and security issues are being considered, you must take "reasonable and prudent care", which is not usually the least expensive option.

Key Control for Housekeeping & Maintenance

The housekeeping and maintenance departments have access to many restricted areas at the hotel. For their own safety and the safety of guests, it is important that all staff understand the appropriate policies and procedures for all keys used in the
department. The items listed below are basic procedures that take place at almost every hotel.

- When staff start work each day they should be assigned a key with a number or code on it. They should always sign their name, key number and the time they checked-out the key on a key sign out sheet. At the end of their shift all keys should be returned to the manager and employees need to sign their name and time stating what time the key was returned. Keys should never be taken home. Keys should never be labeled with the location or description of the area they open. If the keys are dropped and found by guests, then guests have access to restricted areas.

- While employees are working throughout the hotel all keys should be kept in their uniform pocket and or attached to their uniform. Having keys attached to the uniform is the best way to ensure the keys are not left in the open and keys are not lost. Keys should never be left on maid’s carts or work carts.

- If keys are left in guest rooms after the guests have departed, the employee should put the keys in their uniform pocket. During their lunch break all keys should be returned to the supervisor or front desk. This is extremely important since some keys may be programmed for a longer period of time then the guests decided to stay, so they will still work. If these keys are left on maids cart any one could access a guestroom without anyone knowing.

- What to do if a guest states they are locked out of there room? Even if a person claims to be a guest and is walking around the hallways trying to get into a room
you should never let them into any restricted areas especially guest rooms. Tell them that for their safety they need to go to the front office to verify their identification before receiving another guest room key. This may make the guest irritable and frustrated so you must apologize for the inconvenience and reinforce that they must go to the front office for their safety.

- What to do if a person approaches the room you are cleaning and says it is their room? You must not allow the person to enter the room. You do not know if they really are the guest occupying that room. You must ask the guest for their key and open the door using their key. If the key works, then they may be allowed to enter the room.

- What to do if a person, such as visitor, approaches you in the hallway and needs to enter a guest room? You should never ever let people into any restricted areas of the hotel. You must tell the person that they need to go to the front office and be announced as a visitor.

**Other Key procedures for Housekeeping & Maintenance Management:**

- All keys should be labeled with a code not the actual location or space the key opens.

- Key rings should have only the minimum keys required for that employee to use. For example, a room attendant’s key ring should only have a guest room key, laundry chute key and, storage room key. They do not need access to maintenance closets or other areas of the hotel that are not used to perform their
job. Management will need to define what keys should be assigned to each key ring.

- All keys should be on a lanyard or key extender ring. These two options allow the keys to be on the employee’s person and are more likely not left on maid’s carts, PM carts or in guest rooms. It is also helpful especially for employees that have uniforms with pockets to keep keys on their person.

- Keys should never leave the property. All keys should be inventoried and locked in a secure place at the end of each day. It is important that a manager or supervisor inventory the locked box for all of the keys in your department. To do this a Key Audit sheet must be created which is a list of all of the keys used in the department and a date column so you have a record that the keys were inventoried each day. The list should be typed. If any of the keys are missing they must be found immediately or locks must be re-keyed or changed completely.

- Inventory checks must include Fire Department key rings and noted on all checklists.

- A new key sign-out sheet should be used daily. The sign out sheets should be filed by date for one month and kept in an immediate area such as the housekeeping office. After one month the key sign out sheets should be removed and stored with other hotel records for that month.

**Key Machine and Cards**

- One Shot Key - Will only work one time and is active for only 7 days.
• Lock Out key - premade and is valid for 2 years. One to lock the guest out and one to unlock door once issue is resolved. New guest key will override lock out.

• Key Machines check out time is noon but the hotel’s check out is 11am

• 5 Keys per room

• Guest Key/Guest Key DBO – 3 seconds unlocked

• Handicap/Handicap DBO – 7 seconds unlocked (use your discretion)

• Green to Yellow – Battery is going dead, call maintenance

• Green to Red – Staff key is going to expire within 7 days

• Yellow – Deadbolt

• Red – Key is wrong

Fail safe keys are in case of a power outage or other Manager approved issue.

When fail safe keys are used they must be sign out to guest and once the key is used it is only good for 7 days. ONLY GIVE GUEST ONE KEY/VERY IMPORTANT IT IS RETURNED – AFTER 7 DAYS WHEN THAT KEY EXPIRES YOU CAN ISSUE ANOTHER FAIL SAFE KEY FOR 7 DAYS AND SO ON UNTIL ALL 4 FAIL SAFE KEYS ARE USED.

Key Control

• No hotel access keys are to leave hotel property.

• On the cabinet door there is a list of all the keys and what they access.

• When a key is needed:
  o Go to the Front Desk and let the agent know
The Front Desk Agent will need to take the key from drawer 1 for the key cabinet.

The Front Desk Agent will accompany the employee to the key cabinet and unlock it.

The employee taking the key needs to fill out the information on the sign out sheet and have the front desk agent witness the removal.

- Front Desk - You need to take ownership of this process. If you think the person is signing out a key that is not relevant to their job you need to let the MOD know.

Repeat the same steps to return the key and use the time in space where you originally signed the key out.

- Keys are very valuable and need to be kept on your person at all times. (Hence do not leave them in the door they belong to or laying out on counters).

- If you find an unattended key, please return it to the Front Desk and alert the MOD.

**Key Cabinet Inventory**

It is the maintenance person’s responsibility to take inventory of the key cabinet at the end of the AM maintenance shift. (Stop up an hour before leaving). If a key is missing determine whether or not it was signed out. (If it was not or if you notice it wasn’t returned and you know the employee left the building the MOD needs to be notified immediately). Once you have completed the inventory, sign and date it. If there
are no issues put it in Mike’s mailbox. Notify the MOD if there is something you find concerning.

**Housekeeping Key Control**

- Each morning the Executive Housekeeper or Housekeeping Supervisor will sign out the key for the housekeeping key lock box.
- They are then responsible for signing out an individual section key to each housekeeper and signing them back in at the end of the day.
- They will then return the housekeeping lock box key to the front desk and sign it back in.

Locking the doors at night and unlocking them in the morning

- At 7:00 p.m. please use the Allen wrench to lock the employee entrance
- Before the MOD leaves for the evening they should do a walk through and make sure that the conference center entrance is locked and that the handicap door is disengaged. (If there is an event happening we should leave those doors unlocked until the end and the front desk or closing event server should be sure it gets locked).
- If there is not an event going on than the banquet doors by the bar should be shut and locked as well.
- At 11:00 p.m. the night auditor should lock the front door for key card access only.
- When the opening server arrives the auditor should then unlock the employee entrance and the front door. Roughly 5:00 a.m.
- At this time please make sure all the TV are on in the lobby and conference center hallways.

- The morning MOD will determine if the conference center needs unlocked.
ROOM TYPES
ADA = handicap accessible

Presidential Suite – ADA
26 x 21 = 756 sq. ft.

Our magnificent Presidential Suite is the most luxurious of our accommodations, designed to pamper our most discriminating guests. This beautiful space provides gracious views from a sprawling private balcony and is perfect for those visiting on business or pleasure. This Suite is complete with a parlor area and a spacious bathroom with build in Jacuzzi tub.

Executive Suite
32 x 28 = 296 sq. ft.

Executive Suites offer one King or two Queen Beds and are appointed with shades of blue and gray with rich wood accents. Included are well defined work areas and comfortable sleeping arrangements that make you feel right at home. A spacious parlor offers the perfect space to relax and unwind.

King Room – KADA
King ADA: 23 x 19 = 437 sq. ft.
King: 26 x 14 = 364 sq. ft.

All the elements come together to create a warm and inviting experience in true Kent style. From our custom designed furnishings to our richly appointed finishes, our rooms are designed with your comfort and convenience in mind. Our King Room is complete with inviting king-size bed, refrigerator, microwave, iPod docking station and flat screen TV.

Double Queen Room
QQ ADA: 27 x 14 = 378 sq. ft.
QQ: 25 x 14 = 350 sq. ft.

Created in the same style as our King Room, the Double Queen provides are guests with the same richly appointed finishes and custom furnishings. Our Queen Rooms are also designed to provide the comfort and convenience you deserve, including two queen beds, refrigerator, microwave, iPod docking station and flat screen TV.
**STASH BY THE NUMBERS**

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>5</strong></td>
<td><strong>29</strong></td>
<td><strong>2</strong></td>
<td><strong>0</strong></td>
<td><strong>+150</strong></td>
</tr>
<tr>
<td>Members earn 5 points per dollar on room rates prior to tax. Only on eligible stays</td>
<td>Members earn points for up to 29 nights of an extended stay</td>
<td>Members can earn points for up to 2 rooms during a single stay</td>
<td>Members are free to redeem with no blackout dates and points never expire</td>
<td>Members can earn and redeem at over 150 partner hotels in US and Caribbean.</td>
</tr>
</tbody>
</table>

**SUPPORT**

Member Support: StashRewards.com/Contact (redemption changes, missing points, etc.)
Partner Support: partner-support@stashrewards.com
Training and Tools: Commons.StashRewards.com
Stash Hub: www.stashrewards.com/stash-hub/_______________/front-desk
Stash Champion: ________________
Proven Ways to Strike up the Stash Conversation.

The Nordstrom Approach
“Are you earning points for this stay?”

The Road Warrior Test
“Do you travel often? You should check out our loyalty program.”

The Cool & Casual* Method
“Where are you from? […] Oh, we have sister-hotels there…” (grab brochure and present program)
*Made famous by a Rock Star GSA at The Hotel at Arundel Preserve

Natural Times to Talk Stash

When verifying contact info with the guest: This can be a natural lead-in. When you confirm their email address, use that opportunity to introduce the program.

While printing the key card or other check-in tasks: Take advantage of the natural lapse in conversation by asking your guest if they will be earning points for their stay.
INNQUEST ROOMMASTER

Innquest Roommaster Practice

*Change Credit Card Authorizations*

When a guest extends their stay and you need to change their approval amount, be sure to look up the next Total Stay amount prior to following these steps:

- Go to the guest folio: → More Options → Credit Approvals → Highlight the approval → Change Approval Amount (Do not use New Approval if you are just changing the approval) → Type in new amount → Process

When you need to change a credit card while guest is checked in:

- Go to the guest folio → More Options → Credit Approvals → New Approval → Type in amount equal to Total Stay → Swipe card.

After changing credit cards and getting a new approval, you need to erase any other credit approvals.

- Go to the guest folio → More Options → Credit Approvals → Highlight approval you need to erase → Erase Approval → Process.

*Changing Name on Reservation*

If a guest has booked several rooms in one name and you need to change one of the reservations to a different name, *NEVER* type over another guest name, address, etc. or you will overwrite that guests’ profile:
• Go to the guest folio → More Options → Guest Profiles → Insert → Type in new
guest information → OK → once the profile has been created it will be at the top
of the list → DoubleClick the new profile to be inserted into the reservation.

If just adding another name to a reservation:

• Go to the guest folio → More Options → More Names → Find and in Quick
  Rooms/Folios Clean Statues of Rooms → Insert → type in guest info → Close

Companies

There will be times that you will want to have a company in the system so you
can associate a negotiated rate with the company or track the production of the company.

To create a company:

Creating a company when making a reservation:

• Click Other Information → Magnifying Glass next to Company → Insert → Put
  in the appropriate company information. In Details, you can select a rate the
  company gets for their stays, which it’s a Rate Code or an Override Rate.

Creating a company when not making a reservation:

• Press F9 on your keyboard → Company Master → Insert → Put in the
  appropriate company information. In Details, you can select a rate the company
  gets for their stays, whether it’s a Rate Code or an Override Rate.

To select a company name to a reservation:
• Guest folio → Other Information tab → Magnifying Glass (next to company name) → Type in company → Select. Once company has been selected go back to main reservation screen to see if that company has a negotiated rate.

**Direct Bill**

For some reservations, it’s required to bill a company for room charges or all charges. Make the reservation and follow these instructions in the Other Information tab:

• Change Payment Type from CCD to DBR – Direct Bill, Room Only (If the company is paying for all charges, choose DBR – Direct Bill, All Charges).

**Daily Charges & Packages**

To add a daily charge or a package to a reservation or guest folio:

• Go to the reservation or the guest folio → More Options → Daily Charges and Packages → Insert → Select the appropriate code and amount of the item(s).

• If there are packages and charges already created in the bottom half of Daily Charges and Packages → Select the package → add a Package.

**Denial**

This function is used whenever a guest calls to make a reservation but does not reserve. This button is located next to Quick Room. To search for a guest reservation, guest history, or guest profile, the Find button is very useful.

• Find → type the confirmation number, folio number, or last name of person you are searching
• To narrow your search → Click the drop-down arrow next to “Where” and select the correct option

• To narrow your search → Put a time period in the “Lower Check-in” or “Higher Check-in” or both.

**Folios**

Folios allow you to read any Follow-ups (flagged rooms), create Desk Folios (to post miscellaneous items for people not associated with a room number), create group block folios (for a bus group or a group being paid for by one person), and to see a breakdown of all in-house guests.

To create a Desk Folio:

• Folios → Desk Folio → Create Desk Folio → Make your own Folio ID and Folio Name. You can fill out address information and other information as you see it fit → OK

This would be the same process you would set up for a Group, but you would need to follow Automatic Routing to have charges posted to the group folio.

**Gift Cards**

To set up a Gift Cards:

• Click Folios → Desk Folios → Gift Card Sales → First enter the payment → Insert. Enter the code for payment type. 200 = Cash, 202 = Visa/MC etc. → Enter the amount → OK to confirm (credit card will process).
• Now issue the Gift Card → Insert. Enter code 351 – “Gift Card Load” Enter the amount. → OK. Swipe the Gift Card to activate.

• To complete the transaction, press Check-Out. Print two copies of the folio. Folio will re-check-in for next sale.

**Multiple Folios**

Multiple folios are helpful for guests who would like to split charges of their stay between multiple people or their company and personal expenses. To create multiple folios for guests splitting the cost of the room:

• Check a reservation in completely → More Folios → Depending on the number of splits needed (you can do a maximum of 4 Sub Folios), type in the name of each guest in Folio A, Folio B, Folio C, and Folio D → Put the percentage each guest is paying → Under Pay Type, choose the correct payment for that guest → OK.

• Follow instructions in Print Options “For printing all Sub Folios associated with one master folio.”

To create multiple folios for a guest who would like a receipt for the nights his business will pay and a receipt for the nights he will personally pay:

• This is done at check-out. Doing percentages of nights at check-in will still post part of the rental rate on each folio and will not be acceptable for most businesses.

• At check-out → More folios → Put “Personal” in Folio A → Put “Business” in Folio B → Under Pay Type, choose the correct payment for that guest → OK →
Double-click on the room rates (usually labeled “Room Taxable”) → Move →
Select the right folio you’d like the charge to be moved → OK. Do this for each
nightly charge that you need on a different folio.

- Follow instructions in Print Options “For printing all Sub Folios associated with
one master folio."

**Multiple Payments**

At times, guest will want to pay their bill using different payment types:

- Go to the guest folio → Insert → Account List → Payments → Choose the
  method of payment → Insert the amount the guest is going to pay with that
  payment → OK → Repeat steps starting at Insert to post rest of payments on
  folio.

**Automatic Routing**

You can program all transactions or certain transactions to be routed to another folio.

- Go to the guest folio → Transfer → Automatic Charge → Routing → Select
  which folio you want the item(s) transferred to → If needed, you can select
  for which dates → Select which items you want transferred → Apply and
  Reroute Now.

**Print Options**

When you print off a guest folio at check out, there are a variety of printing options to
assist you and the guest. For simple folio printing that will show the folio as it is shown
on your screen:
- Go to the guest folio → Print → in “Pick Folio Type” select Detail Folio → In “Folio Selection” select Master Folio → Print.

For printing all Sub Folios associated with one master folio:
- Go to the guest folio → Print → In “Pick Folio Type” select Detail Folio → In “Folio Selection” select All Sub Folios (this will print all folios listed on your screen) → Print

For printing only certain dates on a folio:
- Go to the guest folio → Print → In “Pick Folio Type select the option you need → In “Folio Selection” select the option you need → More Options → Print Range → Put in the dates you would like to show on the folio → Print.

**Report Favorites**

Each staff member is part of a department that views the needs the same reports each day. By adding these daily reports to the Favorites Tab (the arrow next to Reports button), it saves you time.

- Reports → find and highlight a daily report → Add to Favorites → the daily report will now show in the Favorites Tab.

**Transferring**

There are times when you have to transfer items from one folio to another. Guests paying for multiple rooms and wanting charges on one receipt and bus groups are a few instance when you need to use the Transfer function. Transferring a single or select items to another folio:
- Go to the guest folio → Double-click on the item(s) you’d like to transfer →
  Move → Move to Another Folio → Select the folio you’d like to transfer the item → OK → OK

- If you make a mistake and need the items back to the original folio
  o Go to the guest folio that the items were in (not the one you transferred the items to) Transfer → Return All Items Back to this Original Folio

Transferring all items from one folio to another

- Go to the guest folio → Transfer → Transfer all transactions on Master Folio to another folio → select folio you’d like to transfer charges to → OK → OK
  o When you go to the folio you transferred the items to, you will see the transferred items with the room number surround in red

- If you make a mistake and need the items back to the original folio
  o Go to the guest folio that the items were in (not the one you transferred the items to) Transfer → Return All Items Back to this Original Folio.

**Balance Transferring**

- Go to the guest folio → Transfer → Balance Transfer → you can select to transfer the balance to another folio or, if you have a credit on the folio, you may transfer the credit to another reservation → Select the folio (or reservation) to transfer charges to → put the amount you want transferred → Transfer above Balance Now.
KENT STATE HOTEL AND CONFERENCE CENTER:
SAFETY AND SECURITY

Crisis Communications Plan

After alerting local public safety officials, and ensuring the safety of your guests and staff, the next priority is protecting your hotel’s good name.

Dealing with the Press

The key to successful crisis communications is control of information. Ohio Fire Code dictates the Fire Chief is in charge of all emergencies involving life or property, thus all media communication will be coordinated through the Fire Chief. Every employee must be instructed not to make statements to the press, they should be instructed to refer any questions to the Fire Chief. You are not responsible for investigating crimes, the causes of fires, or other mishaps -- refer these to the responsible authorities.

Never provide names, addresses, or room numbers of guests. Praise your staff and the authorities for their prompt attention to the crisis. Say that you are committing all of your resources to alleviating the crisis and comforting the victims.

The Fire Department will control the Press and will not allow them to gather on or in any unsafe location near the property. Should television, radio or newspaper reporters arrive at your hotel, refer them to the investigating authorities.

Keep a written log listing the name of each reporter, the name of their organization, and their telephone number. Use this list in the event it becomes necessary to make follow-up calls.
Emergency Evacuation Procedures

1. Pull the fire alarm. Call 911 and state the nature of the emergency, be specific.
2. Make a list of all occupied rooms (attach a room layout to the evacuation plan).
3. The fire alarm is the signal for guests to evacuate the building. Allow the Fire Department to evacuate guests and staff are to exit the building and go the designate gathering location.

Notes:

In the case of a tornado, call guests and instruct them to go into the guest room bathroom. Front desk staff should go into the office bathroom, or storage room closet in the manager’s office. If there is a fire, evacuating the building. If there is a fire, do not attempt to fight it unless someone’s life is in danger, or the fire is very small.

4. Utilize other employees, if any, on the property.
5. Call maintenance, 330-631-4786, Jim Staubs and advise him to go to the hotel immediately.
6. Contact the general manager, 330-242-4620, Mike Riccio, and advise him to go to the hotel immediately.
7. Front desk staff are to evacuate the building and allow the fire department to evacuate guests.

Emergency Supplies

The following items should be inspected every week to ensure they are in proper working order. It is very important to verify that the supply inventory is fully stocked and in working order
should an emergency occur. If the hotel is out of any of these supplies, please list them below.

Forward the checklist to the general manager upon completion.

- First Aid Kit stocked
- Flashlights; verify they are in working order
- Weather band radio and transistor radio; verify both are in working order
- Batteries; verify extra supply on hand for flashlights and radios
- Camera and film
- Fire extinguishers - include visual check and sign monthly inspection check, annual compliance check by a licensed technician
- Emergency lights
- Flares
- Chalk (to mark evacuated rooms)
- Hammer, ax, saw, bolt cutter
- Scissors or sharp knives
- Hose (100’ minimum), rope (optional)
- Step ladders, extension ladders
- Electrical tape
- Ample supply of incident reports
- Security log

Items to be restocked: ______________________________________________________________

Checklist completed by: ___________________________________________________________

Date: __________________________________________________________________________

Submit completed report to the general manager
**Bomb Threat**

Statistics say that for every 200 bomb threats received, one bomb is found. There is never such a thing as a routine bomb threat. All bomb threats should be considered real.

**Procedures**

Upon receipt of a bomb threat, or if the presence of a bomb is suspected, immediately:

- Call 911
- Contact the general manager or manager on duty and the chief engineer

In the event a bomb threat is received by telephone, the hotel employee should remain calm and ask the caller the following questions:

1. When will the bomb explode?
2. Where is it?
3. What kind is it?
4. Where are you calling from?
5. What’s the reason for the threat?

Take special note of the caller -- try to determine:

- Background noises that can help locate where the call was made (e.g. traffic noise, music, laughter, machinery, etc.)
- Note caller’s demeanor, calm, excited, etc.
- Was caller well spoken, profane, irrational, coherent, and intoxicated?
- Caller’s characteristics -- sex, age, race, voice, accent, or if the voice was disguised
Gain as much information as possible and record the details immediately. Start a record of all communications and activities during the threat response.

1. Contact all department heads immediately, and tell them to have their employees report outside the building at one of two designated locations determined by the Manager on Duty.
   - Exit the building and walk up the hill past Laziza restaurant and PARTA parking building near the Firestone Tire Center
   - Down Erie St. past Laziza and Bar 145 to Water St.

All employees on duty should immediately report to that area and remain available until they are released by the manager on duty. If the suspected area is the central control point, evacuate employees and guests from that area immediately.

4. Manager on Duty to direct several employees to cover the grounds and guide the police upon their arrival.

5. If the situation dictates, assign personnel to keep stairwells, public restrooms and other public areas under surveillance for unauthorized persons.

6. Do not touch, handle or move any suspicious objects. Examples of areas where bombs may be hidden:
   - Rest rooms
   - Large ash trays
   - Cabinets
   - Equipment rooms
   - Electrical panels
- Water fountains
- Streets
- Sidewalks
- Air ducts
- Items that look out of place
- Areas or equipment that have been disturbed, not normal as previous day
- Suspicious people or activity

If a suspicious package or bomb is found, do not move, touch or disturb it. Evacuate the area and wait for the arrival of the police. A suspicious package or object may be suspect for several reasons:

- Focus on what looks out of place including people
- The package or object may resemble a bomb or be located in a place to fit the circumstances.
- The package or object may not belong to the particular premises or it’s out of place.
- The origin of the package or object may be questionable or not readily determined.
- The physical characteristics of the package may be suspicious in size, shape, weight or audibility.

7. Once a suspect item is located, the general manager or manager on duty should have the immediate area cleared.

- Concentrate on guest evacuation
• Make sure all doors and windows are open
• Evacuate the building
• Contact all supervisors immediately
• Assign a staff member to meet the Kent Police Department outside the building with a property map, guest list and multiple master keys to lead squad to the location
• Wait for further instructions from the bomb squad

Again, although the majority of bomb threats turn out to be no more than threats, these threats should be considered as real until all facts are evaluated or a thorough search is made.

In case of an Explosion:

1. Assist with evacuation and movement of guests, Kent Police Department will secure the area.
2. Allow Fire and Police to assist injured and do not get in their way
3. Assist first responders only when directed
4. Keep all management informed of what has been seen.

**Drought**

In the event of a drought, you can make a significant contribution to your community and win the good will of guests by implementing simple procedures to conserve water, such as:

1. Prepare a letter to be handed out at check-in or placed in each guest room that suggests ways guests can help reduce water use, such as taking shorter showers,
foregoing use of in-room whirlpool baths, flushing toilets less frequently, and avoiding running water constantly when shaving or brushing their teeth.

2. Consider implementing a laundry conservation program that is routinely practiced in so-called “green” or environmentally conscious hotels. The operators of these hotels ask guests who are staying multiple nights to forego daily linen changes and reuse towels and washcloths to reduce pollution and help save water and energy (plus detergent, labor and the need to replace sheets and towels on the part of the hotel).

- To implement this program, place signs in guest rooms and bathrooms to explain the program. Guests are instructed to leave the letter on their beds if they agree to forego daily linen changes and to place only those towels they want replaced in the bathtub.

3. Restaurants and lounges can implement a policy of serving water only on request, considering that 65 percent of complimentary water served is not consumed.

4. On the operations and maintenance side, the following conservation measures can be implemented at little to no cost and little to no disruption to your business:

- Conduct a room-to-room check of all plumbing fixtures to ensure they are operating properly and do not leak. Special attention should be paid to continuously running toilets since they can waste gallons of water every day.
  - Instruct housekeepers to avoid leaving sink taps open while cleaning bathrooms.

- Ensure that laundry loads are maximized before beginning a wash cycle.
• Check all swimming pools and whirlpool baths for drips and leaks.
• For a nominal investment, most hotel operators can realize substantial water savings by installing flow restrictors on faucets and showers. The typical flow rate for a bathroom faucet is three to four gallons a minute, and five to seven gallons a minute for a shower. Restrictors can reduce faucet flow to one-half to one gallon a minute and shower flow to as little as two and one-half gallons per minute.
• Hoteliers interested in cutting even deeper into water consumption should consider installing water recycling, water recovery and ozone systems for the washing machines. Properly financed, the long-term savings should more than offset the cost. Ozone systems improve washing efficiency by charging wash water with ozone gas.
• Turn off lawn sprinklers during a drought.

If you are looking for additional conservation ideas, hotel employees may be your most valuable resource. No one knows your property better than the people who work there every day. Host a breakfast or luncheon to brainstorm the issue. To make the process more fun, create a contest and award prizes for the most creative suggestions.

After a water conservation program is implemented, take it to the next level by developing a property wide recycling and energy conservation program. Employees and guests will respond favorably. The money saved on conservation measures will go directly to the bottom line.

Earthquake
**Before Earthquake**

Assess your work area:

1. **Windows/glass:** If your work station is near windows or glass partitions, decide where you will take cover to avoid being injured by flying glass.

2. **Heavy objects:** If your work station is near a temporary wall or partition, make sure they are securely anchored.

3. **Loose objects:** If you have materials stored on top of cabinets or shelves, determine if these items could be secured or moved.

**During the Earthquake**

1. **Remain calm:** Do not panic or attempt to go outside. Protect yourself.

2. **Act quickly:** Move away from windows, temporary walls or partitions, and/or free-standing objects (files, cabinets, shelves, hanging objects).

3. **Duck:** Duck or drop down to the floor.

4. **Cover:** Take cover under a sturdy desk, table or other furniture. If that is not possible, seek cover against an interior wall and protect your head and neck with your arms.

5. **Hold:** If you take cover under a sturdy piece of furniture, hold on to it and be prepared to move with it.

5. **Stay put:** Hold this position until the ground and/or building stops shaking and it is safe to move. Stay inside, do not attempt to exit the building during the shaking.
If you are outdoors when the quake occurs, stay there. Move away from structures, power poles, lamp posts or retaining walls that could fall during the quake, and avoid fallen electrical lines. If possible, move to an open area.

After the Earthquake

If there appears to be some damage (moved or fallen heavy objects, broken glass, and fallen ceiling tiles), do the following:

1. Check for damage: Carefully inspect your area for damage and/or potentially dangerous situations. Plan for aftershocks.

2. Employees: All employees should then report to the front desk for instructions from the highest member of hotel management on the premises.

3. Limit telephone use: Leave telephone lines clear for emergency communications only. Check all telephones to make sure the receivers have not been shaken off. The phones may not work in PBX. If they don’t, use the pay phones in the lobby to notify all department heads, security, and engineering staff at their homes or on their pagers. Their numbers are available to you in the employee rolodex located at the PBX station.

4. Check for injured persons: Management should form teams with no less than two persons per team. These teams will check all floors for damage and injuries. Each team will have at least one radio, one fire extinguisher, and one flashlight per person. Render, or find someone who can render, first aid to any injured personnel. Emergency Response Team Members (ERTs) or building management
should have access to basic First Aid Kits. Do not move victims unless absolutely necessary.

5. Building damage assessment: One team must be dispatched to check the hot water heater; a second team must check the kitchen, and a third team must go to the laundry room to check for gas leaks. If gas leaks are detected, the gas should be shut off from behind the hotel, unless the gas can easily be shut off at a more local area of the hotel to stop the leak.

6. The PBX operator should inform guests that an earthquake has occurred and that management is presently assessing the damage, if any. Guests should be advised to remain calm.

7. Locate battery-powered radio: Use the radio to receive important instructions and information. The PBX operator is also responsible for monitoring the local AM or FM radio newscasts, and notify hotel management of the latest applicable news.

8. Rumors: Discourage the spreading of rumors. Misinformation can cause confusion and panic.

Earthquake Evacuation

Determine in advance the nearest exit from your work location and the route you will follow to reach that exit in the event an evacuation is necessary. Also establish an alternate route to be used in the event your first route is blocked or it is unsafe to use.

1. Do not evacuate unless told to do so or danger is imminent.

2. Follow instructions given by emergency personnel.

3. Walk, do not run, and keep noise to minimum.
4. Do not use elevators.

5. Do not push or crowd; use handrails in stairwells and move to the right if you encounter emergency personnel.

6. Remove high heels to avoid tripping.

7. Move to your designated evacuation area unless otherwise instructed. Check doors for heat before opening.

8. Assist any non-ambulatory, visually impaired and hearing impaired persons. If you are relocated away from the building, do not return until you are notified that it is safe to return.

*What If You Are in an Elevator?*

If you are in an elevator, you are probably better protected than most people, the elevator is designed to not fall down the shaft, and nothing heavy can fall on you. Many elevators are designed to go to the nearest floor in the direction it is traveling and open. However, some elevators will stop in any moderate earthquake, this is intentional, and they will not be restarted until they are checked by competent personnel and determined to be safe (about 2 to 3 hours).

Building maintenance personnel will contact each elevator car as quickly as possible to determine if there are occupants, advise them how the rescue will occur, and tell them to take directions from the floor warden after departing the elevator car.

If you have a medical or other emergency, call the phone numbers listed in the elevator car. If immediate help is needed call 911.

*When Can You Go Home?*
In the event of an earthquake or community wide disaster during normal working hours, it is in an employee’s best interest to remain at work. It may be too dangerous to attempt to go home right away. Listen to radio reports for areas and roads that have sustained damage. Wait until you know that the roads you need to get home on are in fact undamaged and traffic is moving. While you’re waiting, make yourself available to help fellow employees recover as quickly as possible. Remember, your family’s financial wellbeing will greatly depend on how quickly the hotel can recover and return to normal operations.

FIRE

Hotel fires are more common than most people think. In a typical year, one hotel out of four will have a fire requiring a response from the fire department. Hotel fires are frequently started by cigarettes or other smoking materials, most often in guest rooms. They can also start in storage areas, kitchens and laundries and have electrical or suspicious origins.

Most of these thousands of yearly hotel fires are small, involving little property damage and few injuries, if any. But a small fire can grow quickly and become totally out of control in just a few minutes; the right combination of heat, ventilation and combustible materials can send a fire rapidly from room to room, down corridors, through ventilation shafts until an entire section or wing of the hotel is involved.

These fires can threaten hundreds of hotel guests who are in unfamiliar surroundings, often tired or asleep, with widely varying physical capabilities. They may be multiple stories above the street, well out of the reach of fire department ladders.
A hotel fire does not have to be a major disaster to have a significant effect on the hotel and its employees. Any fire will cause disruption and property damage. The fire can easily lead to injuries and lawsuits. A fire of any proportion will generate adverse publicity, often nationwide, resulting in a loss of business and a loss of jobs.

The two major assets available to prevent a grim scenario are hotel management and hotel employees. Management is in a position to provide the best fire safety equipment and implement a continuous training program for the prevention and emergency response. Hotel employees are the first line of protection they’re on the spot and can discover a fire hazard or deal with a fire in its early stages.

Hotel management should obtain a variety of fire prevention training resources pamphlets, posters, films, video tapes and slide shows to familiarize department heads and employees with the different ways hotel fires start, and the different procedures used to prevent them.

The following information reviews what to do if a fire is discovered, and how to set up a Hotel Emergency Organization. As with the other crisis information in the Building Blocks manual, hotel management is encouraged to use this information to develop their own plan.

**Hotel Emergency Organization**

A Hotel Emergency Organization is a select group of hotel management and employees who receive special training, and have assigned responsibilities in the event of a fire. Before, during, and after a fire, Hotel Emergency Organization members have to know exactly what to do and how to do it right the first time. The management of every
Comfort should review the following information and establish a Hotel Emergency Organization.

**Fire Procedures**

All reports of a fire should be considered real and should be responded to and investigated immediately. Once a possible fire has been reported, the following should be done:

1. Call 911 for all possible fires even if smoke is detected and an actual fire cannot be seen.
2. Determine the necessity for evacuation. If evacuation is necessary, the manager on duty should contact the front desk staff and inform them of the situation.
3. Station an employee in the parking lot to direct the fire department.
4. Run a list of employees punched in and direct staff accordingly.

**Departmental Guide:**

**Front office**

1. Stay calm.
2. Call the Fire Department.
3. Contact the general manager and all department heads.
4. Run the following reports: Room Status Report (Occupied Rooms)
   - In-House Listing
   - Compile list of guests needing assistance (handicapped)
5. Lock cash drawer and put the key in your pocket.
8. Take the Room Status Report, In-House Listing, and list of guests (with room number) needing assistance, along with the Guest Registration Box (the folio Bucket) with you before leaving the building.

Housekeeping

1. Stay clam.

2. The executive housekeeper should ensure that all housekeeping employees have been evacuated from the building.

3. Instruct all employees to put away their carts and report to the designated area. Account for all housekeeping personnel on duty.

4. Once evacuation is complete, assign one employee to meet the fire department when they arrive in order to direct them to the fire.

5. Report to the designated area and verify that all of your employees on duty have been accounted for.

Maintenance

1. Stay calm.

2. Respond to scene. Determine if the fire is real.

3. Do not shut off utilities unless directed by the Fire Department.

4. If the fire is small, assist with putting out the fire with a fire extinguisher.

5. Report to designated area with the rest of the employees and verify that all of your employees on duty have been accounted for.

Manager on duty

1. Stay calm.
2. Respond to the scene. Determine if the fire is real.

4. Assist with inspecting guest rooms to verify that all have been vacated.

5. Verify that all employees have been accounted for. A list of those who were not contacted or accounted for should be kept on hand to give to the fire department upon arrival.

6. Verify that front office personnel have left the building with the proper reports and information.

7. Exit the building. Report to the front lot and verify with department heads that all of their employees have been accounted for.

9. If the media arrives, act as the hotel spokesperson. Follow the Crisis Management Plan.

**Action Points**

_When a Fire is discovered_

- Sound the alarm immediately.
- Begin building evacuation.
- As you escape, shut all doors to help contain the fire.

_When an Alarm is sounded_

- PBX operator call fire department immediately.
- Summon Hotel Emergency Organization members to the Command Center.
- Team members to posts: by elevators, with fire fighter keys, etc.

_If an Evacuation is ordered_

- Evacuate the building.
• Hotel Emergency Organization members go to designated point of assembly.

When tasks are completed, Hotel Emergency Organization members are to return to Command Post. Follow orders of fire department officer in charge.

**Working with the Fire Department**

A Hotel Emergency Organization can benefit in a number of ways from working closely with the local fire department. A good pre-fire plan can save lives and property in case of a fire and cooperative work on fire inspection and code compliance can prevent a fire from occurring in the first place.

Fire departments are typically overburdened and understaffed for the number of tasks they would like to accomplish. Thus you should take the initiative, with a call to the fire safety or public information officer. Tell him/her that you’re upgrading your fire safety program, and want to know what kind of help you can receive from the fire department.

Available resources will vary from department to department, but you should be able to get assistance in three main areas.

**Fire Safety Education**

A fire department with a good public education program will be able to give you literature, and loan audiovisual programs, for training Hotel Emergency Organization members. A public information officer might be able to visit the hotel, demonstrate survival techniques, and answer questions. You may be able to arrange live, hands-on training in the operation of fire extinguishers and hose lines. The fire department also may have CPR and first-aid training classes.
Fire Inspection

Ideally, fire departments should conduct thorough hotel inspections once a year. If they’re having trouble keeping up with it, you can call and request an inspection. A trained inspector will be able to spot problems overlooked in your staff inspections that could cause serious problems later. Fire department inspectors will be conversant with the fire code that applies to your hotel. Code requirements vary for different jurisdictions; for example, most jurisdictions now require smoke detectors in every room.

A fire inspection may require hotel management invest time and money to bring your hotel into compliance. However, consider these points:

- Almost without exception, fire codes are based on testing and research by experts, as well as the careful weighing of costs and benefits by local governing bodies. They are far from arbitrary and represent prudent measures you can take to protect yourself from potentially disastrous losses.
- Although fire departments attempt to educate people, fire code compliance is ultimately hotel management’s responsibility. If a fire were to occur that led to damage suits against you, non-compliance with fire codes would work against you in court.

Pre-Fire Planning

A fire officer in charge will probably make time to visit your hotel and work out a pre-fire plan. This benefits both parties. The fire department will then have on file essential information such as access to hydrants and standpipes, available entrances, potential traffic problems and location of fire fighter’s keys. You will learn the fire
department’s plan of action, so firefighting operations can take place with a minimum of
disruption and danger should your Comfort have a fire.

_Sprinkler Inspections and Tests_

The sprinkler system can only be tested by a certified, licensed person or
company and should be done so monthly. The most critical element in a sprinkler
inspection is the sprinkler valve. Any sprinkler system will have a number of valves at
different points, and a main valve to shut off the whole system. These valves permit
service of the system, and will control water damage once a fire is extinguished. But, too
often, valves are shut off for one reason or another and left off. Time after time,
buildings with adequate sprinkler protection are destroyed by fire because of a shut valve.

There are a number of systems for controlling the shut valve hazard. Some valves
have indictors reading “Open” and “Shut.” All valves should be locked open with
padlock and chain. This is in addition to any tamper alarms that may be present. When
valves have to be closed for maintenance purposes, a closed valve tag system serves as a
constant reminder that protection is out of service.

However, none of these are foolproof. Thus, the monthly sprinkler inspection
must first verify that every sprinkler valve is locked open. The person in charge of
sprinkler inspection should know where every valve is, and develop an exact checklist for
verifying every month.

The sprinkler heads themselves should also be inspected. The most common
hazard here is the obstructed sprinkler head (e.g., a pile of boxes, a new set of shelves, or
some other obstruction, stands between the sprinkler head and the intended pattern of its
spray, reducing its usefulness in case of a fire. Get in the habit of visually checking for sprinkler head obstructions in the course of your inspection rounds. At the least, an 18” clearance should be maintained from the sprinkler head to any storage areas.

Over time, deposits of grease, grime and dust may build up on sprinkler heads, impairing their usefulness. Once a year, maintenance personnel should be assigned to check and clean all sprinkler heads; and, check the overall operation of the system. If your system is wired to a Central Station Alarm, notify the alarm company before performing the test. You will find a valve at the topmost level of the sprinkler system, at the end of the branch line. Opening this valve allows a release of water equivalent to one sprinkler activation. When the valve is open, the water flow alarms should go off within three minutes.

The Inspector’s Test is a means of verifying that water will indeed flow to the most remote sprinkler in the system. If it does not, or if large quantities of dirt and scale come out, your system needs maintenance. Contact your local sprinkler contractor for maintenance, or an overall evaluation of the system.

*Elevator Operations in a Fire*

Elevators can be extremely hazardous in a fire. However, a properly equipped elevator may be a useful means of access in a fire. Fire fighters are trained to operate elevators in fire emergency conditions. Nobody in the Hotel Emergency Organization should attempt this practice with fire fighter’s keys. Staff should never use elevators once fire alarm is sounded.

*Flood*
Floods and flash floods caused by torrential rains or a hurricane are dangerous killers. Even though hurricanes weaken rapidly as they move inland, the remnants of a storm can bring 6 to 12 inches of rain or more to the area it crosses. In the past, numerous floods and hurricanes have each caused millions of dollars in damage and hundreds of deaths.

**Winds**

The winds of a hurricane by definition, 74 miles an hour or more, can be very dangerous. For some structures, wind force is sufficient to cause destruction. Mobile homes are particularly vulnerable to hurricane winds. Some hurricanes spawn tornadoes that contribute to incredible destruction. The greatest threat from a hurricane’s winds is their cargo of debris -- a deadly barrage of flying missiles, such as lawn furniture, signs, roofing, and metal siding.

**Terms to Know**

By international agreement, tropical cyclone is the general term for all cyclone circulation’s originating over tropical waters, classified by form and intensity, as follows:

*Tropical disturbance:* A moving area of thunderstorms in the Tropics that maintains its identity for 24-hours or more. This is a common phenomenon in the tropics.

*Tropical depression:* Rotary circulation at surface, highest constant wind speed 38 miles per hour (33 knots).

*Tropical storm:* Distinct rotary circulation, constant wind speed ranges 39-73 miles per hour (34-63 knots).
**Hurricane:** Pronounced rotary circulation, constant wind speed of 74 miles per hour (64 knots) or more.

**Small craft cautionary statements:** When a tropical cyclone threatens a coastal area, small craft operators are advised to remain in port and not venture into the open sea.

**Gale warnings:** May be issued when winds of 39-54 miles an hour (34-47 knots) are expected.

**Storm warnings:** May be issued when winds of 55-73 miles an hour (48-63 knots) are expected. If a hurricane is expected to strike a coastal area, gale or storm warnings will not usually precede hurricane warnings.

**Hurricane watch:** Issued when hurricane conditions are expected in a specified coastal area within 24 hours or less. Hurricane conditions include winds of 74 miles an hour (64 knots) and/or dangerously high tides and waves. Actions for protection of life and property should begin immediately when the warning is issued.

**Flash flood:** A flash flood is imminent; take immediate action.

**Tornadoes** spawned by hurricanes, sometimes produce severe damage and casualties. If a tornado is reported in your area, a warning will be issued.

**Hurricane**

**The Three Stages of a Hurricane**

**Stage 1—Hurricane alert**

A hurricane alert is issued when a hurricane is 60 hours or several hundred miles away. Winds are between 38-55 mph and, although the storm might appear to be headed in one direction, may change course.
Stage 2 – Hurricane watch

A hurricane watch is issued when the storm is 36 hours away and poses a definite threat. The hurricane may still weaken or be diverted. Winds range from 55-73 mph.

Stage 3 – Hurricane warning

A hurricane warning exists when the hurricane is up to 24 hours away and is expected to strike with winds exceeding 74 mph. When a hurricane warning is issued, all precautions must be taken immediately.

Damage Associated with Hurricanes

- **Flooding** - due to torrential rain and by storm surges.

- **Extremely high winds** - may damage buildings, uproot trees, break electric power lines and telephone lines, and turn loose objects into dangerous missiles.

- **Lightning** - can cause fires and power failures.

Departmental Advance Preparation

**Engineering**

1. Have the landscape contractor cut down any dry limbs of trees that may pose a danger and clear away loose debris.

2. Recommended equipment and supplies:
   - Hard hats
   - Leather gloves
   - Masking tape (2" x 150 ft.)
   - Shovels
   - Ax
   - Saws
   - Plywood and boards
   - Hammers
   - Rain suits
• Rubber boots
• 44 gallon plastic drums, or larger, with covers
• Oxygen cylinder and mask
• First Aid Kit
• Flashlights with spare batteries
• Sand bags (keep filled at all times) and a load of sand
• Plastic covering (100-foot lengths)
• Coil rope 1/2" diameter
• Caulking compound
• Wide brooms
• Mops with wringer pails
• Plastic buckets
• Batteries for in-room radios
• Fluorescent lanterns with spare batteries
• Floating lantern with spare batteries

3. Fill all diesel fuel and liquid propane tanks to capacity.

4. Check emergency generator output and reliability.

5. Take a complete inventory of firefighting equipment.

6. Clean all roofs, gutters and drains to ensure storm runoff can flow freely.

7. Inspect all roofs for defects.

**Housekeeping**

1. Make a list of personnel willing to live on site.

2. Prepare an adequate supply of linens.

**Front Office**

1. Determine list of reports to run in advance of hurricane.

2. Formulate reservations procedures.

3. Prepare communiqués to guests.


5. Maintain the following supplies:
• First-aid kit
• Flip chart and marker

**Accounting**

1. Check that all insurance policies are paid and all risks are properly covered in regard to hurricane and liability damages.
2. Establish cash-control plans.

**General Manager**

1. Establish emergency team.
2. Contact key personnel.
3. Determine site for possible evacuation.
4. Review emergency plans.
5. Determine location for control center.
6. Contact a registered nurse who is prepared to stay on premises to offer medical assistance if needed.
7. Maintain a map of the area to track the hurricane.

**Food & Beverage** (if restaurant operation is on premise)

1. Prepare emergency feeding plans and menus for staff and guests.
2. Maintain adequate supplies of the following:
   - Seven-day supply of water suitable for drinking
   - Disposable forks, knives, spoons, plates, cups and napkins
   - Garbage bags
   - Stereo
   - Charcoal
   - Chafing dishes
   - Containers filled with water for backup
- Flashlights with spare batteries
- First Aid Kit
- Canned food
- Fresh fruits and vegetables
- Bread
- Coffee and tea

**Departmental Stage 1 Preparations:**

**Engineering**

1. Alert emergency team.
2. Double check diesel and liquid propane tanks.
3. Check emergency lighting and emergency generator.
4. Double check firefighting equipment.
5. Secure emergency supplies, shovels, ax, saw and fire extinguishers.
6. Prepare rooms appropriate for storage of lawn and pool furniture.
7. Allow staff to make personal emergency preparations.

**Security**

1. Check building and surroundings. Log and report findings.
2. Confirm that lighting, batteries and radio equipment are readily available at all times.
3. Allow staff to make personal emergency preparations.
4. Review and implement steps to move into the hurricane watch stage.

**Housekeeping**

1. Confirm that emergency supplies are secured on site.
2. Review list of personnel prepared to live on site.
3. Allow staff to make personal emergency preparations.

**General Manager**
1. Confirm the Command Center site.

2. Monitor storm progress.

3. Establish contact with Red Cross and other responsible authorities regarding hotel's status.

4. Keep emergency team informed of developments.

5. Establish contact with other hotels properties regarding mutual aid responsibilities.

6. Determine evacuation transportation needs of guests and staff.

7. Meet with department heads and emergency team to review emergency procedures.

8. Instruct PBX to refer all queries on the hurricane to the general manager or a designated alternate.

9. Issue the hurricane alert notice to guests.

**Front Office**


**Accounting**

1. Maintain supply of small denominations and coins.

2. Confirm computer shutdown procedure.

**Food & Beverage (if restaurant operation is on premise)**

1. Inventory contents of walk-in coolers. Requisition and secure all items to be used during the hurricane.

2. Sterilize and fill all available water containers and store in a safe place.

3. Allow staff to make personal emergency preparations.
4. Review and implement steps necessary to move into the other stages (i.e., watch and warning.)

**Departmental Stage 2 Preparations:**

**Engineering**

1. Confirm:
   - All drains are clear
   - Emergency supplies are secure
   - Fuel and water tanks are full

2. Assign staff to fill remaining sandbags to protect vulnerable internal areas from flooding.

3. Check all supplies and materials needed for boarding windows and doors.

4. Confirm tree limbs near the building are trimmed.

5. Test emergency generator at full load.

6. Turn off pool pump.

7. Remove all garbage from hotel interior.

8. Secure loose debris near building.

**Security**

1. Establish command post.

2. Take any and all steps to ensure safety of people and personal property.

3. Report all unusual events to the general manager.

4. Review action plan to move into hurricane warning phase.

5. Confirm that extra fire extinguishers are at the Command Center.
6. Check all areas and report whether hurricane precautions and preparations are being carried out, and report to the Command Center where attention is necessary.

7. Continue mobile patrols as long as personal safety permits.

**Housekeeping**

1. Move pool furniture inside.

2. Move all outside garbage cans, ash urns and all other loose items inside.

3. Launder all pool towels.

**General Manager**

1. Meet with emergency team to discuss priorities and manpower availability.

   Get names, addresses and phone numbers from department heads and call these persons. These volunteers will be expected to report to the Command Center after securing their own residences.

2. Issue hurricane watch letter to guests.

3. Advise guests of evacuation procedures and transportation options.

4. Arrange transportation for guests to shelter, if desired.

5. Reconfirm mutual aid agreement.

6. Make arrangements for those volunteers who will stay on premises and develop staff roster, requesting staff to bring along a change of clothing and personal hygiene supplies.

**Front Office**

1. Secure all important files and equipment.

2. Arrange to settle guest bills.
3. Review backup computer files and place existing hard copies, account receipts, etc., in secure cabinets away from area of potential flooding.

**Accounting**

1. Secure all important files and equipment.
2. Perform a backup of the accounting material; review backup computer files and place existing hard copies, account receipts, etc., in secure cabinets away from any area of potential flooding.
3. Prepare waterproof containers to store backup discs.
4. Cover all computers in plastic bags to prevent water damage and ensure they are moved above potential flood zone.
5. Ensure that all receipts are deposited before the banks close.
6. Maintain a battery-operated fluorescent lamp for the accounting office.

**Food & Beverage** (if restaurant operation is on premise)

1. Review plans for feeding guests and employees.
2. Move all outside patio tables and chairs inside.
3. Confirm emergency food supplies.

**Departmental Stage 3 Preparations:**

**Engineering**

1. Turn off liquid propane tank at the primary source and remote locations.
2. Set up control logs for distribution of emergency supplies from storage.
3. Tape windows and sliding doors.
4. Put plastic waterproof material on exterior HVAC units facing the direction of the wind.
5. Fill sand bags and place in predetermined areas and put plastic underneath to protect carpet if necessary.
6. Assist in setting up the Command Center.
7. Ensure that all available engineering personnel are posted to their assigned areas.
8. Attach warning notices to each exit door.
9. Install plywood to glass areas of greatest vulnerability to breakage.
10. Conduct a final check of all drains.
11. Lower water in pool by one third.
12. Take down and secure umbrellas and signs.
13. Tie down any other equipment if necessary.
14. Go to 24-hour alert to conduct emergency repairs.
15. Maintain normal utilities until services are lost. If and when utilities are lost, keep only essential items running to conserve generator fuel.

**Security**

1. Assist all areas in securing all exit doors.
2. Keep calm. This will help others to remain calm.
3. Patrol the area to prevent looting and remove all non-residents and non-employees.
4. Record and report any hazardous conditions or damages during patrols.
5. Evacuate guests to their rooms or to an alternative area which is considered to be safe.
Housekeeping

1. Fill three 44-gallon drums with water to be used in public restrooms for flushing purposes.
2. Set up cribs and refrigerators at shelter area to be used if necessary.
3. Move all laundry carts and loose items out of corridor into laundry.
4. Turn off all machines and pilot lights in the event of a power failure.
5. Have large garbage bags available for guests use if required.
6. Fill all tubs in occupied rooms with water for guest use (e.g., for flushing toilets).
7. Use old linens to stuff around windows and under doors to prevent rain from soaking, if necessary.
8. Move inside furniture away from sliding glass, keep drapes closed and sliding glass locked in all rooms.
9. Provide two low-boy candles with matches for each occupied room.

General Manager

1. Record and verify names of staff on duty.
2. Ask department heads to send home all staff not require to be on hand.
3. Keep guests abreast of activities for the duration of the hurricane and distribute games to guests to help pass the time.

Accounting

1. Cover computers and other office equipment.
2. Secure cash, records and keys to drawers in safe deposit boxes.

Front Office
1. Run contingency reports periodically.
2. Obtain list of in-house guests in groups of six by name and room number and distribute to department heads.
3. Write notices and directional signs on flip chart with markers if necessary.
4. Cover computers, switchboards and other sensitive equipment.
5. Take proper safeguards relating to protecting ledgers, records, files, computers, important documents and monies where applicable.
6. Prepare to implement full manual backup system.
7. Secure cash, records and keys in safe deposit boxes.

**Food & Beverage** (if restaurant operation is on premise)

1. Set up tea/coffee/bar station in a sheltered area or a vacant room.
2. Relocate or raise items in storage and in F&B areas that are vulnerable to flooding (e.g., perishable foods and supplies).
3. Prepare safe dining area with tables, for guests (possibly staff lounge).
4. Arrange sterno heating and arrange dishes and food supplies.
5. Chill canned beverages to reduce the need for ice.
6. Assist in taping windows around all F&B areas.
7. Place sandbags at F&B storeroom doors.
8. Fill all available containers with water suitable for drinking.

**The Aftermath**

**General**

1. Assign staff clean-up duties.
2. Remain indoors until advised otherwise by broadcast message or responsible official.

3. Avoid loose wires and report them to the control center immediately.

4. Report all damages to the control center.

5. Stay away from disaster areas unless qualified to offer assistance.

6. Do not drive unless you must because roads should be kept clear for emergency vehicles.

**Engineering**

1. Identify need for contracted services.

2. Identify labor and material needs for damage repair.

3. Itemize structural damage.

4. Itemize other specific damages to equipment and utilities.

5. Assess structural and non-structural weaknesses which contributed damage.

6. Identify, remove and dispose of rubble and debris.

7. Carry out temporary repairs to damaged areas.

**General Manager**

1. Make a brief general assessment and agree on priority activities to pursue.

2. Conduct head count of employees and guests to make sure everyone is safe.

   Arrange alternative accommodations, if necessary.

3. Assign damage assessment team to quantify damage to property.

4. Contact insurance company, if necessary.

5. Activate mutual aid agreements.
6. Provide guests with information on interim arrangements being provided for their comfort and safety. Also provide guests with transportation information.

7. Identify disrupted telephone, power services, water shortages, damage to major transportation routes, and disruptions to public transportation facilities.

8. Contact employees to advise work schedules.

9. Clean up facilities, utilize volunteer assistance.

10. Determine efforts to restore roads, telephone service, water and electricity.

11. Make known any assistance that the hotel can provide to the community.

**Food & Beverage** (if restaurant operation is on premise)

1. Return to normal services as soon as possible.

2. In the event of a severe hurricane, long-term feeding plans for guests and staff must be implemented along with rationing, if necessary.

**Housekeeping**

1. Proceed with cleaning up flooded areas and guest rooms.

2. Return to normal service as soon as possible.

**Security**

1. Patrol and record/report all security risks, including looting, to the Command Center.

**Power Blackout**

In the event that the electrical power should shut off within the building:

1. Contact the general manager or manager on duty, the engineer and the electric company (if possible).
2. Proceed to the elevators and ensure that they are on the first floor; if not, proceed to the floor on which they are located and determine if there are guests in the elevator. If there are, explain to them that you are with hotel management, are aware of their situation, and will resolve it.

3. Walk the hallways and ensure that the emergency lighting is on; if not, calm the guests, and give them directions to the stairwells if they want to evacuate the building.

4. If the property has an emergency generator, check to see if it is functioning properly, making a note if it was used and the condition.

5. Make sure the computers are turned off.

6. If your hotel has a kitchen, ensure that the correct procedures are in place for utility shut down.

In extended power failures, continue to walk the property and update guests on the status.

**Emergency Shut-Off Procedures**

When establishing emergency shut-off procedures, hotel management should attach a map of shut off locations by number.

#1 GAS SHUT OFF

#2 ELECTRICAL SHUT-OFF

#3 DOMESTIC WATER SHUT-OFF

#4 SPRINKLER SYSTEM SHUT-OFF

#5 MAIN FIRE WATER SHUT-OFF

**Tornado**
1. In the unlikely event of a tornado reported in the area, it will be the responsibility of the manager on duty (MOD) to address the hotel guests. The following message should be reported:

“Ladies and gentleman, because of severe weather conditions, hotel management requires that all guests and employees report immediately to the basement down the stairs in the banquet service corridor. Please proceed calmly and quietly and a hotel representative will direct you further. Thank you.”

2. The MOD must collect a list of all occupied rooms in the hotel from the front desk, and disburse members of the housekeeping, front desk, and security departments to those rooms to make sure they are evacuated.

3. The MOD should then inform the security officer on duty (and/or other selected hotel representatives) to direct guests. The officer should inform guests to sit cross legged against the wall with their arms over their heads.

4. At least one front desk clerk should remain at the PBX for as long as possible to handle any communications needs; remaining front desk personnel should gather in the parking lot. If evacuation becomes necessary during the night shift, the auditor should pull the alarm, call the fire/police department, secure the cash drawer and guest folio bucket, and stay by the phone for as long as possible. At all times when evacuation is eminent, the following personnel must be called immediately

a. Chief engineer
b. General Manager
c. Assistant general manager

d. Executive housekeeper

e. Restaurant manager

f. Director of Sales/Marketing

g. Executive chef

Note: The front office manager, or shift supervisor, should read the evacuation notice until relieved by hotel management or fire department personnel.
FRONT DESK DAY TO DAY TRAINING GUIDE

Please initial next to each step when completed by both team members

WEEK #1

Day 1: Getting familiar with the hotel

______/______ Show and explain where items/documents are found in SOP binder, file box, and BEO/Group Resume binder.

______/______ Show log book and explain the importance of logging everything. This is our communication bible from one shift to another.

______/______ Go over hotel layout, location of meeting rooms and names including location of Presidential Boardroom, pool, fitness facility, complimentary continental breakfast, restaurant & room service including times, parking.

______/______ Give new team member keys to the 4 room types that are available (QQ, K, Exec Suite, Pres. Suite) to make note of different layouts. Notice where the pop/ice machines and guest laundry is located.

______/______ Show where and what items are located for replacement (copy paper, Magazines, Stash Reward brochures, key packets, gift cards) in back office.

______/______ Explain Stash Rewards and how it works. Sign into FD Stash Hub and show how to sign a guest up. Make copy of Stash Rewards print out from book for further explanation.

______/______ Explain Signature and how we get scored, the different questions we need to ask for each reservation.

______/______ Show lost/found location under desk and where to document items in roomMaster.

______/______ Explain Service Pro and how to sign in and document maintenance items.

______/______ Show Flashmart and where items are located for replenishment) underneath shelves and back office

______/______ Train how to answer each type of phone call (in-house vs. outside) and how to transfer calls. Explain if a guest room, confirm name in system before transferring

Day 2: Getting familiar with PM Shift

______/______ Have him/her count drawer and show reports that need to be printed for the PM shift

______/______ Explain PM shift checklist and follow throughout shift. Show how to complete a bucket check.

______/______ Have him/her watch FD agent complete several check-ins and explain different type of reservations and appropriate procedures (CC, DB, Cash, ETP).

______/______ Train on how to do check-ins in TRAINING MODE

______/______ Continue making live reservations with guidance of FD agent

______/______ Show how to confirm all reservations are correct including billing prior to

Check-in

______/______ Have him/her count the drawer and have him/her complete drop for the day

Day 3:
Have him/her count drawer and run daily reports needed for PM shift.

Have him/her complete PM shift checklist and follow throughout shift with guidance of FD agent.

Have him/her watch FD agent complete several check-ins and explain different types of reservations and appropriate procedures (CC, DB, EXP, Cash, ETP).

Continue Check-ins in TRAINING MODE. By the end of the day, much know how to check-in guest in TRAINING MODE.

Confirm all reservations are correct including billing prior to check-in.

Continue making live reservations with guidance of FD agent.

Have him/her count the drawer and have her/him complete drop for the day.

Day 4:

Have him/her count drawer and run daily reports needed for PM shift.

Have him/her start PM shift checklist and do the bucket/paperwork.

Have him/her complete check-ins with guidance of FD agent.

Have him/her make live reservations with guidance of FD agent.

Continue training in TRAINING MODE – check-ins and reservations.

Have new team member count the drawer and have him/her complete drop for the day.

Day 5: Run Front Desk.

Have him/her start checklist and do bucket/paperwork.

Run FD PM shift entirely with FD agent there for guidance.
FRONT DESK DAY TO DAY TRAINING GUIDE

WEEK #2
Day 1: Getting familiar with AM Shift
______/______ Have new team member count drawer and show him/her reports that need to be printed for the AM shift
______/______ Explain AM shift checklist and follow throughout shift. Show how to pull registration form in bucket after each check out and where the registration forms are filed.
______/______ Have new team member watch FD agent complete several check outs and explain different types of procedures (CC, DB, EXP, Cash, ETP). Explain who receives a receipt and who doesn’t due to reservation type/code.
______/______ Show how to assign rooms and make key’s for today’s arrivals.
______/______ Show roomMaster TRAINING MODE. Have them view menus and options and how things (availability, quick room, find, profiles, etc.) work in the system. Show differences between KSU DB reservations and Davey Tree DB, difference between ETP and EXP. Train on how to make several different reservations (regular guest, KSU DB, Davey Tree and group) in TRAINING MODE.
______/______ Have new team member count the drawer and show him/her how to complete the drop for the day.

Day 2:
______/______ Have him/her count drawer and run daily reports needed for AM shift and do the bucket.
______/______ Have him/her complete AM shift checklist and follow throughout shift with guidance of FD agent.
______/______ Have him/her watch FD agent complete several check outs and explain different types of procedure (CC, DB, EXP, Cash, ETP). Explain who receives a receipt and who doesn’t due to reservation type/code.
______/______ Show how to assign rooms and make key’s for today’s arrivals.
______/______ Explain EXP reservations and how to transfer virtual credit card to a deposit.
______/______ Continue reservations and check outs in TRAINING MODE. By the end of the day, must know how to make reservations and check-out a guest in TRAINING MODE.
______/______ Have him/her count the drawer and have him/her complete drop for the day.

Day 3:
______/______ Have him/her count drawer and run daily reports needed for AM shift and do the bucket.
______/______ Have him/her start AM shift checklist and do the bucket/paperwork (create favorites for reports).
______/______ Have him/her watch FD agent complete several more check outs.
______/______ Have him/her complete check outs with guidance of FD agent.
Have him/her make live reservations with guidance of FD agent.
Continue training in TRAINING MODE – reservations (DB, regular, group) and check-outs.
Have him/her count the drawer and have him/her complete drop for the day.

Day 4: Run Front Desk
Have him/her start checklist and do bucket/paperwork
Run FD AM shift entirely with FD agent there for guidance.
**DOWNTOWN KENT**  
Within a 5-10-minute walk  
*D = Delivery

### Casual Dining
- Belleria Pizza and Italian Restaurant *D
- Buffalo Wild Wings Grill & Bar
- Dave’s Cosmic Sub *D
- Franklin Square Deli *D
- Fresco Mexican Grill & Salsa Bar Newdle Bar
- Pita Pit
- Pufferbelly
- Taco Tonto’s
- Twisted Melts *D
- Mr. Zub’s *D
- Steak-EEZ

### Fine Dining
- Bricco
- Laziza
- Secret Cellar

### Coffee Shop
- Bent Tree Coffee
- Rise and Shine
- Tree City Coffee & Pastry
- Wild Goats Café

### Bar/Tavern
- 157 Lounge
- Bar 145
- Euro Gyro *D
- Panini’s Bar & Grill
- Ray’s Place
- The Loft
- Water Street Tavern
- Venice Café
- Zephyr Pub

### Sweets and Treats
- Insomnia Cookies *D
- Popped
- Yogurt Vi

### Shops
- 4 Cats Art Studio
- Carnaby Street Style
- Figleaf Boutique
- Flasher’s Fabric Care & Laundry
- GraceyLane
- Off the Wagon Shop
- One Love Yoga
- RUSH by Dino Palmieri
- Skullz Salon
- The Fashion School Store
- The Works
- UniversiTees
- Wild Earth Outfitters
- Woodsy’s Music

---

**LOCAL**  
Akron/Canton/Cleveland

<table>
<thead>
<tr>
<th>Places to See</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kent State University</td>
<td>1.6 miles</td>
</tr>
<tr>
<td>Fred Fuller Park</td>
<td>0.8 miles</td>
</tr>
<tr>
<td>Chapel Hill Mall</td>
<td>6.9 miles</td>
</tr>
<tr>
<td>Aurora Premium Outlet Mall</td>
<td>11 miles</td>
</tr>
<tr>
<td>Blossom Music Center</td>
<td>13 miles</td>
</tr>
<tr>
<td>Wildwater Kingdom</td>
<td>15 miles</td>
</tr>
<tr>
<td>Akron Zoo</td>
<td>15 miles</td>
</tr>
<tr>
<td>Pro Football Hall of Fame</td>
<td>31 miles</td>
</tr>
<tr>
<td>Progressive Field</td>
<td>38 miles</td>
</tr>
<tr>
<td>Rock n Roll Hall of Fame</td>
<td>39 miles</td>
</tr>
<tr>
<td>Cleveland Browns Stadium</td>
<td>41 miles</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sporting Venues</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oak Knolls Golf Course</td>
<td>2.2 miles</td>
</tr>
<tr>
<td>KSU Golf Course</td>
<td>2.5 miles</td>
</tr>
<tr>
<td>The Fairways at Twin Lakes</td>
<td>3.3 miles</td>
</tr>
<tr>
<td>Fox Den Golf Course</td>
<td>4.7 miles</td>
</tr>
<tr>
<td>Kent Lanes – 11th Frame</td>
<td>1 mile</td>
</tr>
<tr>
<td>Twin Star Lanes Bowling Center</td>
<td>2.4 miles</td>
</tr>
<tr>
<td>KSU Ice Arena</td>
<td>1.8 miles</td>
</tr>
<tr>
<td>KSU Recreational Center</td>
<td>1.2 miles</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Churches</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Christian Church of Kent</td>
<td>0.4 miles</td>
</tr>
<tr>
<td>Christ Episcopal Church-Kent</td>
<td>0.5 miles</td>
</tr>
<tr>
<td>Unitarian Universalist Church of Kent</td>
<td>0.4 miles</td>
</tr>
<tr>
<td>Presbyterian Church of Kent</td>
<td>1.1 miles</td>
</tr>
<tr>
<td>St. Patrick Church</td>
<td>0.3 miles</td>
</tr>
<tr>
<td>Trinity Lutheran Church</td>
<td>0.4 miles</td>
</tr>
<tr>
<td>United Methodist Church of Kent</td>
<td>1.0 miles</td>
</tr>
<tr>
<td>Faith Lutheran Church of Kent</td>
<td>0.7 miles</td>
</tr>
<tr>
<td>Water Street Church</td>
<td>1.1 miles</td>
</tr>
</tbody>
</table>
REFERENCE
REFERENCES


satisfaction and intention to stay in the hotel industry. *Journal of Human Resources in Hospitality & Tourism, 4*(2), 99-118. Doi: 10.1300/J171v04n02_06


10.1177/001088049003100113.


Koehler.


programs designed to get the biggest bang for the big buck we’re spending?


